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. PENDAHULUAN

A. Deskripsi Mahasiswa

Mata kuliah ini membahas tentang materi dasar aplikasi komputer dalam
bidang perkantoran. Pembahasan diawali dengan spesifikasi dan perkembangan
hardware komputer, sistem operasi, dan program aplikasi untuk pengolahan kata
yang dalam hal ini difokuskan kepada Ms-Word, Ms-Excel, Ms-Power Point dan Ms-
Access.

Untuk mencapai ketercapaian tujuan dari materi pada mata kuliah ini maka
digunakan metode pembelajaran praktek langsung, problem solving, problem based
learning, discovery learning, small group discussion, dan simulasi. Penilaian
(evaluasi) terdiri dari tiga komponen yaitu TTM 30% (Kehadiran 20%, UTS 40% dan
UAS 40%), TT 30% (MR 20%, TR 20%, JR 30%, dan MRch 30%), TM 30% (MR
60%, dan TR 40%), dan Attitude 10%, yang semuanya bersumber dari tiga aspek,

yaitu kognitif, afektif dan psikomotorik.

B. Capaian Pembelajaran Mata Kuliah

Mahasiswa mampu mengoperasionalkan berbagai program yang berkenaan
dengan Microsoft Word, Microsoft Excel, Microsoft Power Point, Microsoft Access

dan pembuatan media pembelajaran online.

C. Sub Capaian Pembelajaran Mata Kuliah

1. Mahasiswa mampu menjelaskan sejarah dan perkembangan komputer

2. Mahasiswa mampu mengoperasionalkan berbagai program yang berkenaan
dengan Microsoft Word

3. Mahasiswa mampu mengoperasionalkan berbagai hal yang berkaitan
dengan Format dokumen dalam Microsoft Word

4. Mahasiswa mampu membuat table, Clip art, wordart, shape, header and
footer, footnote dan end note, dan penomoran halaman pada Microsoft word

5. Mahasiswa mampu membuat tabel dan gambar pada Microsoft Word

6. Mahasiswa mampu membuat Ms Equation, grafik dan mail marge.

7. Mahasiswa mampu mengaplikasikan Ms. Excel dengan operasi dasar

Workbook, Worksheet, sel dan range sel.
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8. Mahasiwa mampu mengaplikasikan Edit data, Date Series, dan Edit Sel
dalam Microsoft Excel.

9. Mahasiswa mampu mengaplikasikan fasilitas formula yang ada pada
Microsoft Excel

10.Mahasiswa mampu mengaplikasikan fasilitas sortir data yang ada pada Ms.
Excel.

11.Mahasiswa mahasiswa mampu mengatur format halaman sebelum
mencetak dengan program Ms. Excel

12.Mahasiswa mampu membuat media presentasi dari Microsoft power point.

13.Mahasiswa mampu membuat data base dari Microsoft Access.



. PEMBELAJARAN

A. Materi Pertemuan Pertama (Sejarah dan Perkembangan Komputer)

1. Tujuan Materi Perkuliahan: Mahasiswa mampu menjelaskan sejarah dan
perkembangan komputer

2. Materi Perkuliahan

Saat ini perkembangan teknologi informasi sangat pesat terutama penggunaan
komputer telah memasuki hampir setiap kehidupan manusia, sepertinya penggunaan
teknologi komputer ini telah mendapat perhatian besar dari banyak orang di dunia.
Karena banyak hal yang dahulunya dikerjakan manusia secara manual kini telah
digantikan oleh komputer. Penggunaan komputer telah dimanfaatkan di segala bidang
pekerjaan manusia mulai dari mengerjakan pekerjaan yang sederhana sampai
kepada proyek-proyek besar.

Komputer berasal dari kata to compute yang berarti menghitung. Dengan
demikian dapat diartikan komputer adalah alat yang digunakan untuk menghitung
atau alat hitung. Menurut Blissmer (1985), komputer adalah alat elektronik yang
mampu melakukan beberapa tugas, seperti menerima input, memproses input sesuai
dengan instruksi yang diberikan, menyimpan perintah-perintah dan hasil
pengolahannya, serta menyediakan output dalam bentuk informasi. Kemudian,
komputer juga dapat diartikan sebagai suatu perangkat elektronika yang bekerja
secara otomatis, terintegrasi dan terorganisasi sehingga dengan prosedur tertentu
baik masukan maupun hasil proses dan menampilkan hasil proses tersebut.

Di daratan Cina 3000 tahun yang lalu telah ditemukan alat yang digunakan
untuk menghitung yang diberi nama abacus (sempoa) yang terkenal hingga ke Eropa,
dan sampai saat ini alat ini masih digunakan. Penggunaan abacus (sempoa) sangat
memabantu manusia dalam menghitung angkayang lebih besardibandingkan dengan
menggunakan bantuan jari tangan. Namun demikian setelah perkembangan jaman
maka penggunaan abacus (sempoa) masih di rasakan kurang oleh manusia.

Kemudian pada tahun 1617 dari Scotlandia yang bernama John Napier,
menciptakan alat perhitungan perkalian dengan menggunakan tabel bujur sangkar
yang terdiri dari 9 baris x 9 kolom yang berisi angka 1 sampai dengan 9 yang alat
tersebut terkenal dengan nama Napier's Bones. Kemudian seorang ahli matematika
yang bernama Blaise Pascal juga menemukan sebuah mesin hitung mecanis yang
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disebut Pascal’'s Arithmatic Machine. Alat ini terdiri dari roda-roda yang masing-
masing mempunyai sepuluh bagian yang berisi angka-angka dari 0 sampai 9 yang
dihubungkan satu dengan lainnya, sehingga setiap 1 putaran roda akan memutar
roda disebelahnya sebesar 1 putaran.

Kemudian pada tahun 1674 Samuel Morland dan Leibnitz juga telah
menciptakan sebuah mesin hitung yang dapat dipergunakan untuk pembagian dan
perkalian. Alat yang ia buat terkenal dengan nama Lebnitz Calculation Machine.
Kemudian pada tahun 1812 Charles Babbage menciptakan sebuah alat, yang
menututpara ahli sejarah alat yang ia buat ini merupakan cikal bakal sebagai dasar
dari komputer yang dikenal sekarang, alat tersebut dikenal dengan nama Babbage
Calculation Machine. Alat ini memiliki kemampuan dapat menyimpan hasil data
perkalian yang akan dipergunakan untuk operasi selanjutnya dan alat ini juga memiliki
kemampuan untuk menghitung trigonometri dan algoritma secara otomatis.

Kemudian pada tahun 1835 Lady Augusta Lovelace dikenal sebagai
programmer komputer pertama, beliau bekerja sama dengan Charles Babbage pada
mesin Analitical dan menjelaskan tentang fungsi-fungsi loop dan fungsi-fungsi
Subroutine. Kemudian Herman Hollerith dari Amerika Serikat pada tahun 1890 telah
menciptakan suatu mesin Punch Card Accounting yang menggunakan Punchcard
Accounting sebagai media data. Dengan penemuan alat ini maka Hollerich dikenal
dengan sebutan bapak komputer.

Pada tahun 1944 Howard Aiken bekerjasama dengan IBM (Internasional
Busines Machine) Corporation, telah menciptakan komputer pertama yang
menggunakan elekiro mechanis, yang kemudian mesin ini dinamakan MARK I.
kemudian pada dua tahun berikutnya yaitupada tahun 1966 dibuat komputer teknologi
elektronis pertama di Universitas of Pensylveniayang di beri nama Eniac (Elektronical
Numerical Integrated Calculator). Pada tahun 1949 tim dari Cambrige University
membuat komputer dengan nama EDCAS (Elektronic Deley Storage Automatic
Komputer. Dan komputer pertama sekali yang dijual secara komersial oleh Sperry
Rand Corporation pada tahun 1949 yaitu bernama UNIVAC (Universal Automatic
Komputer). Kemudian pada tahun 1950-an perkembangan komputertelah begitu
pesat. Dengan ditemukannya IC (Integrated Circuit), hal ini yang telah membuat
komputerdi jaman sekarang meninggalkan komputer pada masa laulu. Adapun
produsen komputer terbesar saat ini antara lain adalah Amerika, Jepang, Asia. Korea
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sampai pada daratan Eropa.

3. Tugas/ Latihan

Diskusikanlah kedalam kelompok yang berjumlah 3-5 orang, untuk
mendiskusikan terhadap sejarah dan perkembangan komputer mulai dari awal

hingga saat ini.

4. Evaluasi
1) Buatlah Deskripsi singkat tentang pengertian komputer?
2) Jelaskan sejarah munculnya komputer pertama kali dan bagaimana
perkembangan komputer hingga hari ini?
3) Buatlah analisis terhadap hal-hal apa saja yang melatar belakangi

perkembangan komputer dari tahun ketahun?



B. Materi Pertemuan Kedua (Pengenalan Microsoft Word Sebagai Program
Berbasis Kata)

1. Tujuan Materi Perkuliahan: Mahasiswa mampu mendeskripsikan dan
mengoperasionalkan berbagai program yang berkenaan dengan Microsoft Word.

2. Materi Perkuliahan:

Microsoft Office Word 2016 adalah program aplikasi pengolah kata (Word
Processing) yang dapat digunakan membuat dokumen seperti, Laporan, surat,
table, membuat tulisan dengan berbagai variasi (word Art), dan lain-lain.
Microsoft Office Word yang sudah diperbaharui baru-baru ini menambahkan
beberapa fitur yang ada. Terutama memungkinkan pengunanya untuk melihat
dan mengedit dokumen PDF langsung dari Microsoft Office Word itu sendiri.
Kemudian fitur baru yang dibawa oleh Microsoft Office 2016 adalah Fitur Tell me
yang digadang-gadang akan menjadi fitur favorit para pengguna Microsoft Office,
karena fitur ini sangat membantu pengguna. Cara kerja fitur ini sendiri adalah
dengan menginput sebuah kata di kotak yang telah disediakan, kemudian akan
muncul menu-menu apa saja yang berhubungan dengan kata yang telah
diinputkan sebelumnya. Tidak sampai disitu saja pada Microsoft Office Word
2016 telah menambahkan fitur Share dimana fitur ini berguna untuk berbagi
kepenguna lainnya baik melalui email, link, blog dan lain sebagainya.

Microsoft Office Word 2016 merupakan versi Microsoft Office word yang
terakhir (Latest Version) yang ada pada saat ini. Versi Microsoft Office Word
sebelumnya antara lain adalah: Microsoft Office Word 97, 2000, 2003, 2007,
2010 dan 2013.

Pada Perkembangannya Microsoft Office Word selalu memperbaharui dari
segi fitur dan desain Interfacenya. Keunggulan Microsoft Office Word 2016 dari
versi pendahulunya adalah desain aplikasi yang lebih mengutamakan
pengunanya untuk memudahkan aktifitas pengguna saat bekerja di halaman
Microsoft Office Word 2016, dan dari segi fitur Microsoft Office Word 2016
banyak menambahkan fitur baru salah satunya seperti fitur Tell me yang
memberikan kemudahan pengunanya untuk mencari menu menu sesuai dengan

kata yang dinputkan oleh user pada textbox yang telah disediakan.



Pada Bagian ini akan penulis uraikan tentang bagaimana langkah-langkah
pengunaan aplikasi Microsoft Office Word 2016 dengan bahasa dan visualisasi
dengan menyertakan gambar agar pada pembaca lebih memahami dan dapat
mempraktekkan dalam kegiatan sehari-hari khusunya kegiatan pembelajaran di

bidang teknologi informasi.

. Tugas/ Latihan

Diskusikanlah kedalam kelompok yang berjumlah 3-5 orang, untuk
mendiskusikan terhadap perkembangan aplikasi Microsoft Word, perbedaan

versi awal sampai dengan versi yang terkini.

. Evaluasi

1) Tuliskan beberapa kegunaan dari MS. Word?

2) Tuliskan beberapa versi dari perkembangan MS. Word?

3) Tuliskan beberapa kelebihan dari MS. Word 2016, dibandingkan dengan MS.
Word yang lain?



C. Materi Pertemuan Ketiga (Format Dokumen dalam Microsoft Word)
1. Tujuan Materi Perkuliahan: Mahasiswa mampu mengoperasionalkan berbagai
hal yang berkaitan dengan Format dokumen dalam Microsoft Word.
2. Materi Perkuliahan:
a. Membuka MS. Word 2016
Membuka aplikasi Microsoft Office Word merupakan langkah awal untuk
menggunakan aplikasi tersebut. Terdapat banyak cara untuk membuka
Microsoft Office Word 2016, akan tetapi dalam buku ini disebutkan dua cara
dalam membuka aplikasi Microsoft Office Word 2016 tersebut, yaitu:
Cara |.

Melakukan double Klik icon Microsoft Office Word 2016 ¢ yang ada pada
desktop Komputer atau Leptop.

Caralll.

» Klik tombol Start E yang ada pada taskbar.
» Kemudian pilih All Apps. Cari Word 2016.
» Kemudian arahkan pointer ke Word 2016 dan kemudian klik program
aplikasi Word 2016 tersebut.
b. Membuat Dokument Baru
Dalam Microsoft Office Word terdapat fasilitas untuk membuat
dokument baru. Dokument baru dalam Microsoft Office Word sama dengan
lembar kerja baru yang dapat digunakan untuk membuat artikel ataupun
menyelesaikan suatu pekerjaan. Ada beberapa langkah yang dapat
digunakan dalam pembuatan dokumen baru, diantaranya adalah:
Cara l:
Dengan mengunakan tombol shortcut Ctrl+N
Cara ll:
» Klik menu File
» Pilih New
» Kemudian pilih Blank Document
c. Menyimpan Dokumen

Adapun cara untuk menyimpan dokumen baru, diantaranya adalah:



» Tekan Tombol Shortcut Ctrl+ S atau pilih menu File kemudian pilih Save
As

» Kemudian pilih Browse. Di sini merupakan tempat menetukan di drive
mana atau folder mana dokumen yang anda buat akan disimpan.

» Setelah di klik Browse, kemudian letakan file word yang akan disimpan di
lokasi yang sudah ditentukan dan berikan nama file word.

» Kemudian klik tombol Save.

d. Mengatur Font
Pada menu font terdapat tombol-tombol yang memiliki fungsi untuk
mengatur tulisan, seperti pengaturan jenis huruf tulisan, ukuran tulisan,
mengatur pewarnaan pada tulisan, membuat tulisan cetak tebal (Bold),
miring (Italic), garis bawah (Underline) dan lain sebagainya. Fungsi dari

masing-masing tombol pada menu grup font, dapat dilihat pada tabel 1.5.

Tombol Nama Fungsi
Font Mengubah jenis font
FontSize Mengubah ukuran font
Increase FontSize | Memperbesar ukuran font
Decrease FontSize | Memperkecil ukuran font
Clear All Menghapus format font yang
Formatting terpasang pada teks
Italic Memberi efek cetak miring
Underline Memberi efek garis bawah
Strikethrough Memberi efek cetak coret
Subscript Memberi efek cetak bawah
Superscript Memberi efek cetak atas
Change Case Mengubah bentuk penulisan huruf
Text Highlight Memberi warna latar teks dengan
Color warna
Font Color Mengatur warna teks
Bold Memberi efek cetak tebal
Text Effects and Memberikan efek pada teks yang
Typography dipilih




Tabel 1.5: Daftar Tombol Pemfortmatan Teks

Selain menggunakan tombol-tombol perintah dalam grup font, dapat juga

memformat font dengan cara mengklik tombol dialog yang terletak di sudut

kanan nama grup

L~ |

. Selanjutnya akan terbuka kotak dialoh font yang

menampilkan format font yang lebih kompleks untuk memformat huruf.

e. Fungsi Copy (Menyalin)

Copy adalah cara untuk menyalin teks atau gambar kelokasi baru pada

dokumen, langkah-langkahnya yaitu:

>

>

Pilihlah teks yang akan dipindahkan dengan cara mengeblok teks.

[

E

“EIC9PY | atau menekan pada

Klik menu Home lalu Kklik icon Copy

keyboard tombol Ctrl+C, dan dapat juga dengan klik kanan pada teks
yang terpilih lalu klik Copy.
Tentukan lokasi baru tempat menyimpan teks yang kita ambil tadi.

Klik pada menu Home, klik icon Paste atau Ctrl+V yang ada pada
keyboard dan dapat juga dengan mengklik kanan pada tempat baru,

kemudian klik Paste.

Fungsi Cut (Memindahkan)

Cara untuk memindahkan teks kelokasi baru pada dokumen, langkah-

langkahnya vyaitu:

>

>

Pilihlah teks yang akan dipindahkan dengan cara mengeblok teks.

Klik menu Home, pada grup Clipboard, klik icon Cut atau Ctrl+X
pada keyboard dan dapat juga dilakukan dengan klik kanan pada teks
yang terpilih lalu klik Cut.

Tentukan lokasi baru tempat menyimpan teks yang kita ambil tadi.

Klik pada menu Home, klik icon Paste atau Ctrl+V pada keyboard

dan dapat juga dengan mengklik kanan pada tempat baru lalu klik Paste.

g. Delete (Menghapus teks)
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» Pilih teks yang akan dihapus

» Tekan tombol Delete pada keyboard.

h. Perataan Teks

Perataan teks yang ada di Microsoft Office Word 2016 dapat dilihat pada
menu Home dan Grup Paragraf. Tabel di bawah ini menjelaskan fungsi dari
setiap simbol perataan teks. Fungsi simbol perataan teks pada Microsoft Office

Word 2016 dapat dilihat pada tabel 1.7.

Simbol Nama Fungsi
= Align left Untuk perataan Kiri
= Center Untuk perataan Tengah
= Align Right | Untuk perataan kanan
= Justify E;rtml;ir(\ perataan Kiri dan

Tabel 1.7: Simbol Perataan Teks

Bullets, Numbering dan Multilevel List

Microsoft Office Word 2016 menyediakan fasilitas pemberian list
otomatis yang terdiri dari Bulleted List, Numbered List dan Multilevel list.
Ketiga list tersebut memiliki fungsinya masing masing. Fungsi dari ketiga jenis

list tersebut dapat dilihat pada tabel 1.9 di bawah ini.

Simbol Nama Fungsi
— Bulleted Pembe_rlan symbo_l _
i : otomatis pada setiap list
= List -
yang terpilih
Pemberian nomor
= Numbered . L
ey . otomatis pada setiap list
— List ”
yang terpilih
i Multilevel | Penomoran otomatis
=T list bertingkat

Tabel 1.9: Simbol Format List Beserta Fungsinya
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3. Tugas/ Latihan

Diskusikanlah kedalam kelompok vyang berjumlah 3-5 orang, untuk
mendiskusikan terhadap beberapa penggunaan fungsi-fungsi format dokumen
yang ada dalam MS. Word. Kemudian buatlah langkah-langkah penggunaan dari
fungsi-fungsi format dokumen tersebut yang ada pada Ms Word, serta

kegunaannya.

4. Evaluasi
1) Tuliskan langkah-langkah melakukan fungsi copy dan cut dokumen pada Ms.
Word ?
2) Tuliskan langkah-langkah dalam menggunakan fungsi font dalam MS. Word?
3) Tuliskan langkah-langkah dalam menggunakan fungsi perataan, Bullets,
Numbering dan Multilevel List pada MS. Word 20167
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D. Materi Pertemuan Keempat (Membuat Clip Art, Word Art, Shape, Header
and Footer, Footnote, dan Penomoran Halaman Pada Microsoft Word)

1. Tujuan Materi Perkuliahan: Mahasiswa mampu membuat Membuat Clip Art,
Word Art, Shape, Header and Footer, Footnote, dan Penomoran Halaman Pada
Microsoft Word.

2. Materi Perkuliahan:

a. Clipart
Clipart sendiri dapat disisipkan pada teks disebuah paragraf. Adapun
langkah-langkah dalam pembuatan Clipart, diantarnya adalah:
» Letakkan kursor pada paragraf yang akan disisipkan objek Clipart.

» Kemudian pilih menu Insert.

| |
L
Jdriire

» Selanjutnya klik icon Online Pictures [,

» Kemudian klik Bing Image Search, maka akan tampil kotak dialog

seperti gambar 1.34 di bawah ini.

Ir st = chrres

Is  irvane sar sarz

S e s - Barescal

Gambar 1.34: Tampilan Insert Pictures Ms. Word

» Setelah di klik Bing Image Search, maka akan muncul kotak dialog,
dimana anda dapat mencari gambar atau objek yang sesuai dengan
yang diinginkan.

» Setelah melakukan pencarian dan pemilihan type yang dirubah menjadi
Clipart, maka akan ditampilkan beberapa pilihan Clipart. Pilihlah salah
satu gambar atau objek tersebut dan klik tombol Insert.

b. Membuat WordArt

WordArt berguna untuk menampilkan berbagai bentuk serta membuatnya
dalam bentuk tulisan yang indah. Untuk cara pembuatan WordArt dapat
mengikuti langkah-langkah di bawabh ini.

> Klik menu Insert.
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] ‘WorcArt~

» Selanjutnya pada grup text pilih icon WordArt
» Pilih style WordArt yang diinginkan. Hal ini dapat dilihat pada gambar 1.41

di bawah ini.

A A
AlA A A
A A A

Gambar 1.41: Style WordArt

» Kemudian akan terlihat tampilan style WordArt yang telah pilih tadi. Pada
contoh gambar di bawah ini penulis memilih style WordArt dengan
tampilan biru. Hal ini dapat dilihat pada style WordArt yang akan diedit
pada gambar 1.42.

Your text here

Gambar 1.42: Edit Style WordArt

» Kemudian edit teks WordArt sesuai dengan yang diinginkan. Pada contoh
gambar di bawah ini akan dibuat dengan merubahnya menjadi kata
“pendidikan”. Hal ini dapat dilihat pada gambar 1.43.

Pendidikan

Gambar 1.43: Teks WordArt Yang Telah Diedit

c. Shapes
Shapes merupakan fasilitas yang disediakan oleh Microsoft Word yang
dapat dimanfaatkan untuk membuat bentuk bangun tertentu. Untuk
pembuatan diagram alir dengan mengunakan shapes dapat dilakukan
dengan:
» Klik menu Insert pada grup lllustrations.

Py,

Shapes

» Kemudian klik Shapes
14



» Setelah di klik menu shapes, maka akan terlihat berbagai macam Shapes.
» Setelah muncul kotak dialog di atas, maka pilihlah bentuk Shapes yang
akan digunakan. Tarik salah satu shapes yang dibutuhkan ke halaman
kerja. Pada contoh di bawah ini digunakan bentuk shapes, yaitu Rounded

Rectangle, Parallelogram, dan Rectangle.

d. Penomoran Halaman
Menambahkan nomor halaman dalam suatu dokumen dengan
menggunakan tombol perintah Page Number yang terdapat pada grup Header
& Footer pada tab Insert atau dalam toolbar Header & Footer Tools.
Langkah-langkah pembuatanya, yaitu:
» Klik menu Insert
» Kemudian pilih Page Number pada grup header & Footer. Di dalam menu
page number maka pilih salah satu style yang diinginkan.
1) Bottom of Page: digunakan untuk menampilkan daftar nomor
halaman yang akan ditempatkan di area judul kaki atau footer.
2) Top of Page: digunakan untuk menampilkan daftar pilihan nomor
halaman yang akan ditempatkan di area judul kepala atau header.
3) Page Margins: digunakan untuk manampilkan daftar pilihan nomor
halaman yang akan ditempatkan di area margin dokumen.
4) Current Positions: digunakan untuk menampilkan daftar pilihan
nomor halaman yang akan ditampilkan pada sembarang posisi. Posisi

ini ditentukan oleh posisi insertion point di dalam dokumen.

3. Tugas/ Latihan
Buatlah artikel dengan isi sebanyak tujuh halaman terkait dengan pendidikan,
ekonomi dan sosial, dengan ketentuan:
1) Pada bagian judul di buat dengan menggunakan WordArt
2) Pada artikel tersebut di sisikpan gambar (Clipart) atau di dalamnya
disisipkan diagram Alir (shapes)

3) Kemudian artikel tersebut dibuat nomor halamannya

15



4. Evaluasi
1) Tuliskan langkah-langkah membuat penomoran otomatis pada Ms. Word?
2) Tuliskan langkah-langkah menyisipkan gambar dan membuat tulisan indah
dengan menggunakan Ms. Word?
3) Tuliskan langkah-langkah menggunakan fungsi shapes pada Ms. Word?

16



E. Materi Pertemuan Kelima (Membuat Tabel Pada Microsoft Word)

1. Tujuan Materi Perkuliahan: Mahasiswa mampu membuat tabel pada Microsoft
word.

2. Materi Perkuliahan:

Microsoft Office Word merupakan aplikasi pengolah kata akan tetapi bukan
berarti tidak dapat mengelolah angka. Pada aplikasi Microsoft Office Word ada
feature tabel dimana terdapat kolom dan baris pada sebuah tabel. Perpotongan
antara kolom dan baris dinamakan sel. Dapat juga menyisipkan teks ataupun objek
gambar dalam sel-sel tersebut. Untuk cara pembuatan tabel dapat dilakukan
dengan cara di bawah ini.

I

Tzule

> Pilih menu Insert. Kemudian Table

» Ada 2 cara dalam menetukan baris dan kolom pada pembuatan tabel.
v’ Cara yang pertama dengan mengeser mouse pada kotak— kotak sampai
mendapatkan ukuran tabel yang diinginkan dan lepaskan mouse.
v’ Cara kedua dengan memilih menu pada Insert Table sehingga muncul kotak
dialog Insert Table, yang dapat dilihat pada gambar 1.29.

Insert Taklz 4

Tabieclze
Fumber of colimns & =
Humber ol jows: 3
Ainlis behseinr
(@) Fiwew tolumwidihe  [Auio
(_) AuboBlt to conkents

(0 Aubal it o windan

D Remznbe: Cimersions [or newr lebles

Gambar 1.29: Kotak Dialog Insert Tabel

» Setelah menentukan baris dan kolom pada tabel yang akan dibuat, maka

pembuatan tabel telah selesai.

17



3. Tug

as/ Latihan

Buatlah tabel di bawah ini dengan menggunakan Ms. Word

Daftar Nilai Mahasiswa

Nilai

No Nama Kehadiran | UTS | UAS Jumlah | Rata-Rata
1 | Aisyah 80 70 85
2 | Fatimah 90 80 70
3 | Khadijah 78 87 77
4 | Hajar 77 76 90
5 | Ibrahim 87 89 78
6 | Mahmmud 88 88 87

Jumlah

Rata-Rata

4. Evaluasi

1) Tuliskan langkah-langkah membuat tabel dari Ms. Word?

2) Buatlah satu tabel di bawah ini dengan menggunakan Ms. Word.

Daftar Penjualan Barang Elektronik

Tahun 2016

Nama Jumlah Barang Harga
No Barang Terjual Perunit | JuMlah
1 |TV 120 200000
2 | Kulkas 48 400000
3 | Kipas Angin 86 350000
4 | AC 77 430000
5 | Komputer 90 500000
6 | Laptop 110 450000

Jumlah
Rata-Rata

Keterangan Pengerjaan:

Buatlah tabel di atas.

Kemudian carilah jumlah dan rata-rata menggunakan formula.
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. Materi Pertemuan Keenam (Membuat Ms Equation Dan Mail Marge)

1. Tujuan Materi Perkuliahan: Mahasiswa mampu membuat Ms Equation, dan

mail marge.

. Materi Perkuliahan:

a. Equation

Equation merupakan fasilitas yang terdapat pada Microsoft word untuk

memasukkan rumus dan symbol yang tidak terdapat dalam keyboard. Dengan

adanya equation, rumus-rumus yang rumit dapat dibuat dan diselesaikan.

Adapun langkah-langkah dalam membuat rumus matematika atau simbo-

simbol matematika dengan menggunakan Equation, antara lain adalah:

>

Klik menu Insert

Kemudian pada grup symbol, maka klik Equation.

Setelah itu, akan muncul kotak dialog.

Kemudian pilih Insert New Equation.

Setelah mengklik Insert New Equation akan disediakan kotak khusus untuk

memasukkan rumus matematika, yaitu: Type equation

i;Typg equation here. |
here ! x
Selain itu juga menu Design akan keluar saat mengklik Insert New Equation.
Pada menu ini disediakan beberapa format pembuatan Rumus Matematika.

Gambar 1.80 di bawah ini merupakan tampilan menu Design untuk

pembuatan Equation.

Gambar 1.80: Pemilihan Format Equation

Pada menu Design inilah dapat di buat rumus matematika sesuai dengan

yang diinginkan.

» Setelah semuanya selesai, klik diluar kotak equation.
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b. Mail Marge

Microsoft Word menyediakan fasilitas untuk membuat suatu dokumen,
dimana dokumen tersebut dicetak dalam jumlah yang banyak dengan format
yang sama tetapi ada beberapa bagian dari dokumen tersebut yang berbeda.
Mail Merge berfungsi juga untuk membuat sertifikat, label, dan amplop.

Ada dua file yang harus dibuat yaitu file surat yang berisi format surat
dan file data yang berisi data-data seperti halnya database. Contohnya
seperti Nama, Alamat dan lain sebagainya.

Untuk langkah-langkah pembuatan Mail Merge dapat dilakukan dengan
cara di bawah ini:

Cara membuat File Master

» Klik menu Mailings

> Kiik Start Mail Merge. Pada bagian ini akan ditampilkan beberapa

pilihan. Maka pilihah Letters

Keterangan:

= Letters: untuk membuat dokumen berbentuk surat.

= E-mail: untuk membuat surat yag akan dikirim ke alamat E-Mail.
= Envelopes: untuk membuat amplop

= Labels: untuk membuat label surat.

Ketik sebuah surat. Gambar 1.72 di bawah ini merupakan contoh dari

format surat.

SURAT PENGANTAR
Hizpaacia -
Yeh.

Coesrggennt Hurnl,
Cengan Tl Kaml hertzhuka n pedrclan kamisl untuk panjualan barang
Fer Triviutan sebagal hesut:

Mama Basang

lumiah Terjual

Herga :

Demikdan surat pemberttahuan ik kaml sampalksn. Akas pechatanma
kamil upaskar terima kasth.

Gambar 1.72: Contoh Format Surat
Membuat File Database
Setelah format surat atau format lainnya telah dibuat, maka langkah
selanjutnya adalah membuat file database. Adapun langkah-langkah dalam

membuat file database adalah:
20



» Klik menu Mailings

[—
| =
)b

e
» Pilih pada grup Start Mail Marge, maka pilih Select Recipients Fesipicrts-
» Kemudian setelah di pilih Select Recepients, maka akan keluar kotak
dialog yang terdapat tiga pilihan, maka pilihlah Type a New List. Hal ini

dapat dilihat pada gambar 1.73 di bawah ini.

m qt
L2 ]
Se|=ct (Wl

Reripirnss~ Recipient | it

=] by g Mawd Ll

[E degan Siztng Liz.

[&E] Chrnse Frore O flnae Tretorss

Gambar 1.73: Type a New List
Keterangan:
» Type a New List: Membuat file database baru.
» Use an Existing List: mengunakan database yang sudah ada.
» Choose From Outlook Contacts: Mengunakan data dari Contact

Outlook atau dengan kata lain mengirim ke kontak email Outlook.

» Setelah memilih menu Type a New List, maka akan keluar kotak dialog
New Address List, seperti pada gambar 1.74.

e oW

Tpaucphn el e rEwan . Foadd senoradn bt iy,
i wliatan wlidHer  witmiaskow el ihnlet -

Gambar 1.74: Kotak dialog New Address List
» Setelah muncul kotak dialog New Address List, maka pilih Customize

Colums. Maka kemudian akan menampilkan kotak dialog Customize
Address List, seperti pada gambar 1.75.
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Gambar 1.75: Kotak Dialog Customize Address List

» Sebelum mengisi data, maka hapuslah terlebih dahulu data file name
dengan menekan tombol Delete. Setelah semua data file name terhapus
maka buat file baru dengan mengklik tombol Add.

» Kemudian klik OK.

» Setelah proses pembuatan field selesai. Maka lakukanlah penginputan
sebuah data yang nantinya akan digunakan sebagai data di lembar
surat. Untuk menambah data maka dapat mengklik tombol New Entry.

Hal ini dapat dilihat pada gambar 1.76.

K EXETET Iy 1 -

gl el Lo lioailmris s in s alab Eeamaln
| e - | v -lF= e Wiy = i e -] e

Gambar 1.76: Kotak Dialog Proses Penginputan Data

» Setelah data dimasukan maka lakukan penyimpanan database. Buat
nama databasenya, mislanya: “DATABASE”. Kemudian klik Save.

» Setelah melakukan penyimpanan database maka pembuatan database
telah selesai. Maka tahap selanjutnya adalah menentukan dibagian
mana file tersebut akan ditempatkan.

» Untuk memasukkan data dari database ke dokumen yang hendak
digandakan, maka arahkan kursor ke arah kolom tersebut kemudian klik
Mailings.
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» Kemudian pilih Insert Merge Field ek pada grup Write & Insert
Fields. Contoh pada gambar 1.77 di bawah ini, merupakan proses Insert

Merge Field yang diletakkan di kolom tertentu.

SURAT PENGANTAR
Kepada
th
aMenime
whlrmato
whchze

Lezngen Hormmak,
Cengan Il Karl sertshukzn penncias komist untuk perjualan barang
Per Trisulen sebagai herie:

Maria Zarmng  xMama_Berangs
Jumlab Terjusl = JLrmlzh_Domangs
Hermm : wHarcps

Dmikian surat pemberitaboen in kami sampeian, &kas portatiannye
kani vjapkan berima kasih,

Gambar 1.77: Proses Insert Merge Field Pada Dokumen

%)
s

> Berikutnya tinggal klik tombol Priview Result L=+ |, Jika ingin menganti

data ke data berikutnya, maka dapat mengklik tombol navigasi yang ada
di grup menu Preview Results ke kanan atau ke Kkiri atau dengan
menganti angka 1 ke angka berikutnya sesuai data keberapa yang anda
ingingkan. Hal ini dilihat pada gambar 1.78.

| M40 > M
E? Frrd F'.-..-r.ir_lil:r L

Prev e :
Becults r:', Check For Errorz

Provizve HesuEs

Gambar 1.78: Preview Result
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3. Tugas/ Latihan

Buatlah surat di bawah ini dengan menggunakan fungsi Mail Marge

SMK PAB 4 KLUMPANG

JI. Klumpang K ebun K ecamatan Hampar an Per ak

Klumpang, 08 April 2018

No :K-4/63/PAB/VIII/2018
Lamp :
Hal : Undangan Mengisi Pelatihan

Kepada Yth,
Bapak <<Nama>>
Di

Tempat

Assalamualaikum Wr. Wb.

Dengan hormat, dengan perantara surat ini, kami doakan semoga Bapak dalam
keadaan sehat wal’afiat dan sukses selalu dalam menjalankan aktifitas sehari-
hari.

Sehubungan dengan kegiatan pelatihan rutin tahunan di sekolah ini, kami
mengundang bapak untuk dapat hadir mengisi pelatihan fardhu kifayah, yang

insya Allah akan dilaksanakan pada:

Hari : <<Hari>>

Tanggal : <<Tanggal>>

Pukul . <<Pukul>>

Tempat : SMK PAB 4 Klumpang

Demikianlah surat ini kami sampaikan, atas kehadiran bapak kami ucapkan
terima kasih.

Wassalamu’alaikum Wr.Wb.

Kepala Sekolah
SMK PAB 4 Klumpang

Drs. H. Masliana Daulay
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4. Evaluasi
1) Tuliskan langkah-langkah dalam menggunakan fungsi mail marge dan
equation pada Ms. Word?

2) Tuliskan beberapa rumus di bawah ini dengan memanfaatkan fungsi

equation pada Ms. Word

B
F=—X100%
N

r . .k 1 _:tr:
2 E
\‘[”: I Ra
o (ny —1)5,% + (n, —1)5;°
N o, — 2
| -
nXfLX,*— (X fiX,)?
t ,q' n(n—1)
|30(85,8975) — (50,55)*
= 30(30 - 1)

N
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Materi Pertemuan Ketujuh (Mengaplikasikan Ms. Excel)

Tujuan Materi Perkuliahan: Mahasiswa mampu mengaplikasikan dasar-dasar
Ms.Excel.

Materi Perkuliahan:

a. Mengenal Microsoft Excel 2016

Microsoft Excel atau Microsoft Office Excel adalah sebuah program aplikasi
lembar kerja spreadsheet yang dibuat dan didistribusikan oleh Microsoft
Corporation yang dapat dijalankan pada Microsoft Windows dan Mac OS.
Microsoft Excel digunakan untuk melakukan operasi perhitungan serta dapat
mempresesntasikan data dalam bentuk tabel dan grafik. Microsoft Excel
2016 ini merupakan penyempurnaan dari versi-versi pedahulunya.
Secara spesifik perbedaan Microsoft Excel 2016 ini dengan Microsoft Excel
versi sebelumnya terletak pada tampilan lembar kerja yang lebih menarik
dengan desain menu yang lebih mudah dalam penggunaannya. Walaupun
demikian bahwa program Microsoft Excel 2016 ini, dapat menyesuaikan
dengan versi sebelumnya yang lebih rendah seperti pada Microsoft Excel
2003.
Fitur baru yang di bawa oleh Microsoft Excel 2016 adalah Fitur Tell me yang
dipandang akan menjadi fitur favorit para pengguna Microsoft Office. Hal ini,
karena fitur ini sangat membantu bagi para pengguna. Cara kerja fitur ini
sendiri adalah dengan menginput sebuah kata di kotak yang telah
disediakan, kemudian akan muncul menu-menu apa saja yang berhubungan
dengan kata yang telah diinputkan sebelumnya. Kemudian pada Microsoft
Office Excel 2016 telah menambahkan fitur Share dimana fitur ini berguna
untuk berbagi ke penguna lainnya baik melalui email, link, blog dan lain
sebagainya. Ekstensi atau format penyimpanan pada Microsoft Office Excel
adalah xlsx. Namun format tersebut dapat diganti menjadi format lain seperti
format PDF.

b. Membuka Microsoft Excel 2016

Cara membuka Microsof Office Excel 2016 ada beberapa cara, namun pada
pembahasan ini akan dijelaskan dua cara dalam membuka aplikasi Microsof

Office Excel 2016, di antaranya adalah:
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Cara I:

Mendoubel klik icon Microsoft Office Excel 2016 yang ada pada
desktop.

Cara ll:

» Klik tombol Start E yang ada pada taskbar.

» Kemudian pilih All Apps.

» Kemudian cari Excel 2016.

» Kemudian arahkan pointer ke Excel 2016 dan kemudian klik program
aplikasi Excel 2016 tersebut.

» Setelah di klik program aplikasi Microsoft Office Excel 2016, maka akan
menampilkan tampilan awal lembar kerja seperti pada gambar 2.2 di

bawabh ini.

e

Gambar 2.2 Tampilan Awal Microsoft Excel 2016
Keterangan:

1) Kolom search: berfungsi untuk melakukan pencarian template atau
tema dari projek atau dokumen yang ingin anda buat.

2) Open Other WorkBooks: berfungsi untuk membuka kembali
dokumen atau lembar kerja yang pernah anda buat sebelumnya.

3) Blank WorkBooks: berfungsi untuk membuat halaman kerja baru
dengan tampilan kosong atau dengan kata lain tidak memiliki desain
apapun yang terdapat pada lembar kerja.

» Jika ingin memulai pekerjaan dengan mengunakan Microsoft Office

Excel, maka pilihlah menu Blank WorkBooks untuk memulai tahapan

awal.
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Setelah melakukan langkah-langkah di atas dalam membuka aplikasi
Microsoft Office Excel 2016, maka akan tampil halaman kerja Microsoft
Office Excel 2016. Di bawah ini merupakan tampilan kerja Microsoft Office
Excel 2016. Pada penjelasan selanjutnya akan sering disebutkan kata
Workbook dan Worksheet. Workbook merupakan file dari Microsoft Excel
sedangkan Worksheet merupakan lembar kerja dari Microsoft Excel. Adapun
lembar kerja Microsoft Office Excel 2016 dapat dilihat pada gambar 2.3 di

bawah ini.

Gambar 2.3: Tampilan WorkBook
Keterangan:

1) Toolbar Quick Access: Secara default

berisi tombol Save, Undo, dan Repeat

(Redo). Namun jika ingin menambah maka
dengan mengklik tombol panah ke bawah |: - ;:I'.:“‘:
yang terdapat pada toolbar quick access :

yang terdapat diujung kanan. Dan jika sudah
dipilih untuk di menu Toolbar Quick Access -f

maka sudah terlihat tercentang seperti
. o Gambar 2.4:
gambar 2.4 disamping ini. Ouick Access Toolbar
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1)

2)

2)

3)

4)

5)

6)

7)

8)

9)

Menu Bar: Merupakan menu-menu yang memiliki fungsi yang berbeda-
beda setiap menunya. Menu bar terdiri dari Menu File, Home, Insert,
Design, Layout, References, Mailings, Review, View dan yang terakhir

adalah Tell me. Menu Bar dapat dilihat pada gambar 2.5 di bawah ini.

Bl ot e Fealc I CReiw W Beehet o T mravopesize

Gambar 2.5: Menu Bar Ms. Excel
Ribbon: Berisi beberapa group icon dimana setiap icon memiliki fungsinya

masing-masing. Hal ini dapat dilihat pada gambar 2.6 di bawah ini:

G
i o= e W Tes Fawul - |_|'-‘=

Gambar 2.6: Ribbon Ms. Excel
Name Range Fungsi: merupakan sebuah kolom dimana anda dapat
memasukkan sebuah fungsi.
Sel Aktif: Sebuah kolom dan baris yang sedang dipilih atau yang sedang
aktif.
Scrool Bars: Berfungsi untuk mengeser halaman kerja kearah bawah
atau atas.
Lembar Aktif: Menginformasikan bahwa anda sedang berada pada
lembar kerja di Sheetl.
Penggulung Horizontal: Untuk mengeser lembar kerja karah kiri dan
kanan.
View Control: Berfungsi untuk menampilkan dokumen menjadi mode
Normal, page layout dan page break priview. Kemudian terdapat Kontrol
Zoom berfungsi sebagai penentuan ukuran halaman kerja di layar pada

jendela Microsoft Excel 2016.

Menambah, Menganti dan menghapus Sheet

Menambah Sheet

Klik pada icon tanda “Tambah”

Sheet! | (T

Menganti Nama Sheet

Double Klik pada Sheet, kemudian ganti nama sheet tersebut —-2m2r "
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3) Menghapus Sheet
Klik kanan pada Sheet kemudian pilih Delete. Proses penghapusan Sheet

dapat dilihat pada gambar 2.7 di bawah ini.

el
[& Driee

Terzme

Hrre i Louym
g it
L_" Jrnbert Saert...

Tak Coiof

icle

el Sl Sheel

| Sheet]

Gambar 2.7: Proses Penghapusan Sheet

d. Format Kolom dan Baris

1) Merubah Ukuran Kolom
Untuk mengubah ukuran kolom dalam Microsoft office Excel 2016, langkah-
langkahnya adalabh:
» Letakkan pointer dipembatas kolom yang ingin dirubah ukurannya, lalu
drag sesuai dengan ukuran yang diinginkan. Hal ini dapat dilihat pada

gambar 2.8 di bawah ini.

' 1irmg perubstns
* lealnnn

Gambar 2.8: Proses Drag Pembatas Kolom
» Jika ingin merubah ukuran kolom lebih dari satu kolom, maka blok kolom

yang ingin dirubah ukuran kolomnya menggunakan mouse. Prosesnya

dapat dilihat pada gambar 2.9 di bawah ini.
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Gambar 2.9: Mengeblok Beberapa Kolom Yang Ukurannya Dirubah

> Kemudian klik menu Home. Kemudian pilih Format, i
» Pilih Column Width, kemudian Isi lebar kolom.
> Klik OK.
2) Merubah Ukuran Baris
Untuk mengubah ukuran baris dalam Microsoft Office Excel 2016, langkah-
langkahnya adalah:
> Letakkan pointer pada pembatas baris yang akan dirubah ukurannya, lalu
drag ke bawah sesuai dengan ukuran yang diinginkan. Hal ini dapat dilihat

pada gambar 2.10 di bawah ini.

Gambar 2.1: Proses Mendrag Baris

» Untuk merubah ukuran baris lebih dari satu baris, maka blok baris yang ingin
dirubah menggunakan mouse. Hal ini dapat dilihat pada gambar 2.11 di bawah
ini.
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Gambar 2.11: Mengeblok Beberapa Kolom yang akan dirubah Barisnya

+ Fanva
» Kemudian klik menu Home. Pilih icon Format = = |
» Kemudian pilih Row Height, kemudian isikan nilai lebar baris dan kemudian

tekan OK.

e. Membuat Dokumen Baru

» Klik Menu File
» Kemudian Klik New atau cara yang lebih mudah dengan menekan tombol
pada keyboard Ctrl+N. Pilih Blank workbook.

f. Menyimpan Dokumen

1) Menyimpan dokumen baru
» Klik menu File
» Klik Save As, maka akan muncul kotak dialog.
» Kemudian klik Browse. Maka akan muncul kotak dialog pilihan dimana file
tersebut akan disimpan. Pilih Direktori dimana anda akan menyimpan file

tersebut. Hal ini dapat dilihat pada gambar 2.13 di bawah ini.

Gambar 2.13: Pemilihan Directori Penyimpanan Ms.Excel

» Ketikkan nama file, pada File Name dan Pilihlah type penyimpanan, Misalnya
Excel Workbook atau Excel 97-2003 Workbook, pada Save as type.
» Kemudian klik Save.
2) Menyimpan Dokumen Yang Sudah Pernah Disimpan Sebelumnya.
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Cara seperti ini pada umumnya digunakan ketika sudah pernah
menyimpan file tersebut dan kemudian melakukan sebuah perubahan atau
editing, maka agar perubahan atau editing tersebut tidak hilang maka dilakukan
penyimpanan kembali. Adapun cara melakukan penyimpanan dokumen yang
sudah pernah disimpan sebelumnya adalah:

» Klik menu File.

» Kemudian klik Save atau dengan cara menekan tombol keyboard Ctrl + S

secara bersamaan atau dengan mengklik shotcut E pada Toolbar Quick
Access.

g. Menutup Dokumen

Dalam menutup dokumen pada Microsoft Office Excel, terdapat beberapa
cara diantaranya adalah:
» Klik menu File

» Kemudian klik Close atau menekan pada keyboard tombol Alt+F4 atau

menekan tanda silang Toolbar Quick Access.
» Kemudian akan muncul kotak dialog yang didalamnya terdapat pilihan yang

terdapat pada gambar 2.14 di bawabh ini.

[dicrosaf: Ence 4

! FearTio saee your charges to ool "

rerTrrrell e

Gambar 2.14: Proses Menutup Dokumen Ms. Excel

Keterangan:

Apabila muncul pertanyaan seperti pada Gambar di atas, tandanya bahwa

dokumen yang dikerjakan belum disimpan baik dokumen baru maupun

dokumen lama yang telah dirubah. Terdapat tiga tombol yaitu:

= Yes: untuk menyimpan dokumen/file ke file dokumen baru (jika belum
disimpan sebelumnya).

» No: untuk keluar dan abaikan penyimpanan.

* Cancel: untuk membatalkan perintah keluar.
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3. Tugas/ Latihan
> Buatlah tabel di bawah ini

BIODATA MAHASE WA FAL LMSU
NO fARLA JENIS KELANMIN ALARMAT

1|Rudi Setiawan Lakl-Laki I Merceka Ujung Mo. 23
Alarfin Sanci Laka Laki I Miondalc Ypung Mo, 21
JAhmaz lefiz Laki-Laki JI. L=mbaga Pemasyarskatan
AlAhmas B=7a I abi-1aki I Marelan
5|Rudi 1Rz Laki-Laki . Tembung
5| Ricwan S=ndi Laki-Laki I Mz ndals Tengah No. o
7|Elmil sy ahpitr Peremcouan I Msrencal Moo 3
lAmni I'cromeouan Ji. Mcdu lambu

Ketentuan Pengerjaan:

Buatlah tabel di dalam Sheet 1 kolom C2

4. Evaluasi
1) Tuliskan beberapa langkah-langkah membuka aplikasi Ms. Excel?
2) Tuliskan langkah-langkah menambah, mengganti dan menghapus sheet?
3) Tuliskan cara menyimpan dokumen pada aplikasi Ms. Excel?
4) Tuliskan cara membuat dokumen baru dan langkah-langkah menutup

aplikasi Ms. Excel?
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Materi Pertemuan Kedelapan (Mengaplikasikan Edit Data, Date Series, dan

Edit Sel dalam Microsoft Excel).

Tujuan Materi Perkuliahan: Mahasiwa mampu mengaplikasikan Edit data, Date

Series, dan Edit Sel dalam Microsoft Excel.

Materi Perkuliahan:

a. Mengunakan Undo dan Redo
Dalam Microsoft Office Excel terdapat dua pengulangan, yaitu Undo dan
Redo. Fungsi ini berfungsi untuk melakukan perulangan apabila terjadi
kesalahan pada saat melakukan pekerjaan di dalam Aplikasi Microsoft Office
Excel.

» Undo adalah untuk membatalkan perintah yang baru saja diberikan

pada Microsoft Excel. Caranya dengan menekan icon Undo pada
quick access toolbar atau dengan menekan Ctrl+Z pada keyboard.
» Repeat adalah untuk mengulang perintah yang baru saja diberikan pada

Microsoft Excel. Caranya dengan menekan icon Redo begitupun
fungsinya yaitu untuk membatalkan perintah Undo.

b. Mengabungkan Cell
Dalam Microsoft Excel di dalamnya terdapat baris dan kolom. Gabungan
antara baris dan kolom tersebut dinamakan cell. Dalam penggunaanya
terkadang antara beberapa cell tersebut perlu digabungkan agar menjadi
suatu table atau data yang baik. Untuk menggabungkan beberapa cell
menjadi satu, adapun langkah-langkahnya adalah:
» Sorot beberapa cell yang akan digabung.
» Klik menu Home.

» Kemudian perintah Merge & Center ==l Merge & Center - yang terletak pada
grup Alignment.
» Jika ingin melakukan pemindahan baris teks secara otomatis dipindahkan

ke baris berikutnya, terus sampai ke akhir halaman atau teks area. Maka

dapat menggunakan fungsi Warp Text 1= Wiap Text yang terletak pada

grup Alignment yang ada pada menu Home.
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c. Nomor Berurut

Berbeda dengan Microsoft Word, pada Micrososft Excel pembuatan

penomoran dapat dilakukan secara automatis, yaitu dengan membuatnya

secara berurutan. Adapun cara memebuat penomoran berurutan secara

automatis adalah:

> Ketik angka pertama pada sel yang diinginkan.

» Ketik angka kedua pada sel selanjutnya (berurutan).

> Blok kedua sel tersebut secara berurutan.

» Letakkan pointer pada sudut kanan bawah hingga keluar tanda tambah +
kemudian sorot ke bawah sampai nomor yang kita inginkan. Hal ini dapat
dilihat pada gambar 2.15.

;74-_4

Gambar 2.15: Pembuatan
Nomor Berurut

d. Mengatur Orientasi Tata Letak Teks
Adapun langkah-langkah untuk membuat karakter pada teks menjadi ke
bawah seprti gambar di bawah ini, yaitu:
» Pilih teks yang ingin anda ubah orientasinya.

> Klik menu Home.

&\l nimept

> Klik pada tanda panah icon Alignment|

Pada Horizontal pilih dan klik Center.
Pada Vertical pilih dan klik Center.

YV V VYV

Kemudian tambahkan nilai degrress jadikan menjadi -90, seperti pada

gambar 2.16 di bawah ini.
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Gambar 2.16: Proses Pembuatan Karakter Teks Ke Bawah

» Kemudian klik OK.

e. Mengatur Posisi Teks

f.

Teks yang dibuat pada Microsoft Office Excel dapat diatur posisinya, baik
pada rata kiri (Align Left), kanan (Align Right), tengah (Center) dan lainnya.

Adapun langkah-langkah mengatur posisi teks antara lain adalah:

» Blok teks yang ingin dilakukan pengaturan posisi teks.

> Klik menu Home

» Pada grup menu Paragraph pilih salah satu icon seperti pada gambar

2.17 di bawah ini.

Icon | Keterangan | Fungsi | Icon | Keterangan | Fungsi
= Top Align Perataan | — | Align Left Membuat
- dengan | — perataan

rata atas Kiri
. Middle Align | Perataan | — | Center Membuat
o dengan | — perataan
rata tengah
tengah

| Bottom Align | Perataan | — | Align Right Membuat

= dengan = perataan
rata kanan
bawah

Gambar 2.17: Ilcon Pengaturan Posisi Teks Ms. Excel

Membuat Garis Pada Tabel
Pada Microsoft Office Excel terdapat menu untuk membuat garis pada tabel.
Untuk membuat garis pada tabel dapat dilakukan dengan langkah-langkah,
yaitu:
» Blok seluruh sel yang ingin diberi garis tabel.
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> Klik menu Home.

» Kemudian pilih Border

, yang ada pada grup Paragraph. Pilih style
garis tabel yang ingin anda buat, kemudian pilih salah satu dari style

tersebut.

g. Membuat Simbol Mata Uang
Dalam Microsoft Office Excel dalam penggunanya terkadang membutuhkan
beberapa symbol untuk memperjelas berbagai informasi, seperti
menggunakan symbol mata uang untuk menjelaskan hal yang terkait
mengenai jenis mata uang. Adapun lagkah-langkah untuk membuat symbol
mata uang atau lainnya, yaitu:
» Blok semua angka yang ingin diberi simbol mata uang, misalnya Rp.

> Klik menu Home

» Kemudian pilih Accounting Number Format - yang ada pada grup
Number.
» Kemudian pilih More Accounting Format. Maka setelah itu akan

menampilkan kotak dialog Format Cells, pada gambar 2.18 di bawah ini.

xxxxx

|

Gambar 2.18: Format Cells Ms. Excel

» Pilih Accounting, pada Symbol pilih Rp Indonesia. Dan pada Decimal

Place, ganti menjadi “0”. Kemudian klik OK.

h. Template Microsoft Excel 2016
Pemilihan template digunakan untuk mendapatkan pilihan desain yang
bervariasi, dengan bantuan template memungkinkan tidak perlu membuat
desain tabel lagi. Adapun langkah-langkah pembuatannya adalah:

» Klik menu File. Kemudian pilih New.
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» Kemudian lakukan pencarian template dengan mengetikkan jenis
template apa yang diinginkan, misalnya dengan mengetikkan Billing

Statement. Hal ini dapat dilihat pada gambar 2.19 di bawah ini.
J|Z w

Gambar 2.19: Pencarian Template Ms.Excel

» Kemudian pilih salah satu template, selanjutnya klik Create. Seperti pada

gambar 2.20.

Gambar 2.20: Pembuatan Template Pada Ms. Excel

» Kemudian lakukan pengeditan seperti menganti nama perusahaan, kode

pos dan lain sebagainya. Hal ini sebagaimana gambar 2.21.
s o e ===
L T —

Gambar 2.21: Hasil Pemilihan Template

Membangun Rumus dengan Operator Matematika dan

Pembanding.

Microsoft Excel menyediakan banyak fungsi yang dapat digunakan
untuk membangun rumus dalam pengolahan data yang berupa angka
maupun teks. Rumus yang akan dibentuk dapat dituliskan pada bagian
formula bar. Rumus yang ditulis dalam Microsoft Excel diawali dengan

tanda = (sama dengan). Sebagai contoh rumus pengurangan antara nilai 5
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dengan nilai 1 dapat ditulis dengan bentuk: =5-1. Hasil perhitungan rumus

akan ditampilkan dalam sel.

1)

2)

Operator Matematika

Operator matematika merupakan operator yang digunakan untuk
melakukan operasi matematika seperti perkalian, penjumlahan,
pengurangan dan lain sebagainya yang digunakan dalam Microsoft

Office Excel seperti pada tabel 2.1.

Operator Fungsi Contoh Penulisan Rumus
Mengelompokkan operasi _ .
9 matematika =@+5)*(2/3)
=8**5
A Perpangkatan —gnsg
. _ , =21*7
dan/ | Perkalian dan pembagian =21/7
, =25+55
+dan - | Penjumlahan dan pengurangan | — 40 . 2g
% Persen = 25* 100%
& Menggabungkan dua data teks = "Sistem” & "Informasi

Tabel 2.1: Operator Matematika

Operator Pembanding

Operator pembanding merupakan operator yang membandingkan
dua buah nilai atau variabel yang akan menghasilkan nilai benar atau
salah. Contohnya pada perbadingan nilai “14>=13 “, yang artinya 14
lebih besar sama dengan 13. Perbandingan ini akan menghasilkan nilai
benar karena 14 lebih besar dari 13. Operator pembanding dapat dilihat
pada table 2.2.

Operator Fungsi Contoh Pengunaan
Operator
= Sama dengan Al =B1
> Lebih besar dari Al >B1
< Lebih kecil dari Al <B1
>= Lebih besar dari atau Al >=B1
sama dengan
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<= Lebih kecil dari atau Al <=Bl1
sama dengan
<> Tidak sama dengan Al <>Bl1

3. Tugas/ Latihan

Tabel 2.1: Operator Pembanding

» Buatlah tabel di bawah ini pada Ms. Excel

DAMTAR HARGA DARAMG

v i famfay Harga Rarang Total Harza
Bzrang Barany
1TV 2 Unil Rp 100,000 | Rp 200,000
2 KULEAS 3 Unit Rp 2,000,000 | Rp 50RO, 000
3 DISFEMNSER A Unit Rp 27,000 | Rp B0, 000
4 AL S umit Hp 13000 | Bp bal, D00
L VLD 4 Lt Hp 23000 | Bp AL, 0O
& MOBIL 5 Unit g AE50,000 | Rp 13,250,000
7 SCPCCA 3 Uit g 2000,000 | Rp £ 000, 000

Ketentuan Pengerjaan:

1) Buatlah tabel di dalam Sheet 2 kolom B3.

2) Buatlah nomor berurut dengan secara otomatis.

3) Buatlah simbol mata uang (Rp)

4. Evaluasi

1)
2)

3)
4)

Tuliskan langkah-langkah menggabungkan cell aplikasi Ms. Excel?

Tuliskan langkah-langkah membuat atau menampilkan simbol mata uang

pada aplikasi Ms. Excel?

Tuliskan cara menampilkan garis pada tabel di aplikasi Ms. Excel?
Tuliskan langkah-langkah dalam melakukan pemilihan template pada Ms.

Excel?
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Materi Pertemuan Kesembilan (Mengaplikasikan Fasilitas Fungsi Sum,

Average, Min, Max, Product, Count, dan Rank pada Microsoft Excel.

. Tujuan Materi Perkuliahan: Mahasiswa mampu mengaplikasikan Fungsi Sum,

Average, Min, Max, dan Rank pada Microsoft Excel.

. Materi Perkuliahan:

a. Fungsi Sum (Penjumlahan)
Sumber fungsi untuk melakukan penjumlahan sekumpulan data pada suatu
range, adapun bentuk pengetikannya adalah:= SUM (numberl, [number2]..)
Contoh: = SUM (B5:C5)

S =EUR B, )

R i -

| 4] alefess) |

Gambar 2.30: Pengunaan Fungsi Sum

b. Fungsi Product (Perkalian)
Product berfungsi untuk melakukan perkalian sekumpulan data pada suatu
range, adapun bentuk pengetikannya adalah:
=Product (numberl, number2,..)
Contoh: =Product(B5,C5,D5)

FREODUITCIIRLE

PSR YL TN [ LR LT LU § (YT T i =

| 2] e 3|=FRODUCTIGS,2,05) |

Gambar.2.31: I.Dengu.naan Fungsi Product

c. Fungsi Max (Nilai Tertinggi)
Max berfungsi untuk mencari nilai tertinggi dari sekumpulan range. Adapun
bentuk pengetikannya adalah: =MAX (numberl, [number2],...)
Contoh: =MAX (C5:H5)

fo | =Waxitis)

r F F 2 H il 5

[T TN T R | Al
Gambar 2.32: Pengunaan Fungsi Max

d. Fungsi Min (Nilai Terendah)
Min berfungsi untuk mencari nilai terendah dari sekumpulan data (range).
Bentuk pengetikannya adalah: =MIN (numberl, [number2],...)
Contoh: =MIN (C5:H5)
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AN | HS )
Le o EE | I 4 |
[0 | om0 &e0 | oo | Ba0 & | 53]
Gambar 2.33: Pengunaan Fungsi Min

e. Fungsi Average (Rata-Rata)
Average Dberfungsi untuk menghitung nilai rata-rata, adapun bentuk
pengetikannya adalah: =AVERAGE (numberl, [number2],...)
Contoh: =AVERAGE (C5:H5)

) =AVLRACTZEIE)

c o E T L} H | o

| IEEE ST ATEC Bl BT TS | T3]

Gambar 2.34: Pengunaan Fungsi Average

f. Fungsi Count (Menghitung Jumlah Data)
Count berfungsi untuk menghitung jumlah banyaknya data dari suatu range
yang dipilih, adapun bentuk pengetikannya adalah:
=COUNT (valuel, [value?],.....)
Contoh: =COUNT(B5:B8)

2 =CCUINT]ES:H5)
L L = F 15 H

[ S I T T, T T S T O T VI O T | [+l
Gambar 2.35: Pengunaan Fungsi Count

g. Fungsi Rank (Mencari Rengking)
Rank berfungsi untuk mencari rangking, adapun langkah penggunaanya
adalah:
Ketikan, tanda = kemudian ambil pada nilai yang akan diuji, kemudian
ketikkan koma atau titik koma (, / ;), kemudian blok semua nilai jumlah yang
akan dibandingkan kemudian tekan pada keyboard tombol F4, kemudian
koma, kemudian ketikkan 0). Angka “0” berfungsi untuk mengurutkan secara
Descending.
Adapun bentuk pengetikannya adalah: =Rank (humber, ref, [order]). Contoh:
=Rank (B3, $B%$3:$B$7,0)

3. Tugas/ Latihan
» Buatlah tabel di bawah ini pada Ms. Excel, dengan ketentuan untuk mencari

rengking dengan menggunakan rumus =rank mengunakan kolom Nilai Angka.
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Laporan Nilai Mahasiswa Ujian Akhir Semester Ganijil
Tahun 2014-2015

No Nama Nilai Angka Rengking
1 | Rani 80

2 | Ahmad Andika 86

3 | Riki Darmawan 70

4 | Nurhalimah 74

5 | Andi 75

6 | Firdaus 90

7 | Siti Aminah 78

8 | Fatimah 65

9 | Linda Wati 78

10 | Sugeng Wanto 56

4. Evaluasi
1) Tuliskan langkah-langkah membuat penjumlahan, mencari

rata-rata,

rengking, nilai maksimum, nilai minimum, dan perkalian pada Ms. Excel?

2) Buatlah tabel di bawah ini pada Ms. Excel, dengan ketentuan

Mencari jumlah yaitu dengan rumus = Sum

Mencari rata-rata yaitu dengan rumus =Average

Mencari rengking yaitu dengan rumus =Rank

Mencari nilai maksimum yaitu dengan rumus =Max

Mencari nilai minimum yaitu dengan rumus =Min

LAPORAN ILASIL UJIAN

M

MARA

MILAITES

umilaly | BRS

ral4

Hangking

RUD

=0
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20
20

A
59

e e b | =

RIMI

20

30

EN T Y]

Al | =S Al | A
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rata-rata

Milai Maksimum

Milai Minirooemn

B BN

sl ] ] (=]

EVR ERCH ERE RN P FREEPTH
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J. Materi Pertemuan Kesepuluh (Mengaplikasikan Fungsi Logika IF, AND, OR
pada Microsoft Excel.

1. Tujuan Materi Perkuliahan: Mahasiswa mampu mengaplikasikan Fungsi Logika
IF, AND, OR pada Microsoft Excel.

2. Materi Perkuliahan:
Fungsi logika disebut dengan bersyarat, yang memungkinkan bagi kita untuk
menguiji persyaratan dalam sel. Fungsi logika adalah suatu kondisi yang hasilnya
bergantung pada benar atau salahnya pengujian. Fungsi logika dalam

penggunaanya memerlukan operator perbandingan.

/ Operator Perbandingan: \
= (samadengan)
< (lebih kecil dari)
> (lebih besar dari)
<= (lebih kecil sama dengan)
>= (lebih besar sama dengan)
<> (tidak sama dengan)

. )

a. Fungsi If Tunggal

Fungsi if digunakan untuk memilih diantara dua nilai, berdasarkan dua kondisi
yaitu kondisi benar dan kondisi salah. Adapun bentuk pengetikkannya adalah:
=IF(logical_test, [value_if true],[value_if false]).

Contoh 1: =IF(A2>50,"Naik Kelas”,"Tinggal Kelas”)

Mo Nama Nilai |I(eter;mgﬂn |
1 Rudi EI-‘]:IF{CE>=?E,"Fiai£ Kelas”, "Tinggel Kelas")
2 Rinz 75| |IFHlogical test, [vaiue if zruel [value if Falzz])
3 Sefiawan a7

4 Ranl 73
5 Rian 23

Gambar 2.43: Pengunaan Angka Pada Fungsi IF

Artinya, jika nilai sel C3 lebih besar atau sama dengan 75, maka dinyatakan
“Naik Kelas”, namun jika nilai sel C3 kurang dari 75 maka dinyatakan “Tinggal
Kelas”.

Contoh 2 : =IF(C3="A","Sangat Baik”,”"Buruk”)
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No  [Mama Milai |ICntu:rJnEan
1| Rudi :ﬁ. ]:lf{CS:".ﬁ.". "s2pgal Baik","Buiuk")
2{Rina B B IFingiral test walie ©_is] Galue r Felse]) |
J[Setiavwzn Z Durik
4|Ranl # BurLk
5|Rian b4 Sangat Baik:

Gambar 2.44: Pengunaan Huruf Pada Fungsi IF

Artinya, jika nilai sel C3 bernilai A, maka bernilai “Sangat Baik”, dan jika selain
bernilai A, maka akan bernilai “buruk”.

b. Fungsi If Majemuk

Contoh: =IF(C3>=90,"A",IF(C3>=80,"B",IF(C3>=70,"C","D")))

Mo Mama Milai Angka Milai [luruf
1 fudi =i £32=00," A" M| C3=00,"D"IT( C12=70.'C"," D 1)
2 Mlinz | | [Fhogicz] tost, 'rn“u-.'._il:_l:rucll [wahoe f fal=c]) |
3 Zetizwan i C
4 Rzni 70 C
3 Risn =0 A

Gambar 2.45: Pengunaan Fungsi IF Majemuk

Artinya jika pada sel C3 bernilai 90, maka bernilai “A”, dan jika pada sel C3
bernilai 80, maka bernilai “B”, dan jika pada sel C3 bernilai 70, maka bernilai “C”
dan jika tidak bernilai “D”.

c. Fungsi AND

Untuk membandingkan dua buah data atau lebih, dengan ketentuan
bahwa jika semua data dipenuhi. Adapun bentuk pengetikkanya adalah:

=IF (AND(Perbandinganl, Perbandingan?2))

Contoh:

=IF(AND(D3>65,E3="single"),”lulus”,"gagal”)

| 54 LRI ﬁri.;F:E.;‘E.:Eéﬁﬁﬂltf-'":i'IE'E':,'l.;il':llrl 2 diiolah"]
' 5 B C D E ; 5 K |
1
2 LAPZRAN HAsIL Lilak MASLE KERIG
3
4 HZ WARKTE KILAI TES| STATLE [HAELL
5 1ruct i Dflezlc  |dicdn:
i RN tmonlkak :[=.::F’~EEE5351:="]E "sHerma’ il
T i 4 3)|simgln A Diicgivall, |coived?, JuyicaC] .. |
3 4 bl 33| monilkaf

Gambar 2.46: Pengunaan Fungsi AND
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d. Fungsi OR

Untuk membandingkan dua buah data atau lebih, dengan ketentuan
bahwa salah satu kriteria terpenuhi (bernilai benar). adapun bentuk
pengetikkannya adalah:
=IF(OR(Perbandinganl, Perbandingan2))
Contoh:
=IF(OR(D3>65,E3>70),“Lulus”,"gagal”)

oy LR Y. | =|F|OR{CaxE5, 0870, 'diterima ', "ditolal ')
A B C D E F 5 b

AHIEEM HASE JNAN MAY K EFRIL

v |

NG NAMA abiss HASIL
A B
6| 1Ruci 30 70 -IF| OR! 06235, 0670}, "ditzrima”, ‘ditolak”)
7 2 RlAN 20 0 | IFilcgical_tast [velue i true], [alie 1-Ta e} |
H EE e il h&
2 FINI i 80

Gambar 2.47: Pengunaan Fungsi OR

3. Tugas/ Latihan
Buatlah tabel di bawah ini pada Ms. Excel, dengan ketentuan:

Ketentuan Pengerjaan:
1) Buatlah tabel di atas

2) Carilah rengking dengan menggunakan rumus =rank mengunakan kolom
Nilai Angka.
3) Carilah hasil dengan fungsi IF, dengan ketentuan bahwa jika nilai angka

lebih besar dari 75 maka hasilnya, “lulus” jika tidak maka hasilnya “tidak
lulus™.

Laporan Nilai Mahasiswa Ujian Akhir Semester Ganijil
Tahun 2014-2015

No Nama A’\rlllgljakla Rengking | Hasil
1| Rani 80
2 | Ahmad Andika 86
3 | Riki Darmawan 70
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4 | Nurhalimah 74
5 | Andi 75
6 | Firdaus 90
7 | Siti Aminah 78
8 | Fatimah 65
9 | Linda Wati 78
10 | Sugeng Wanto 56
4. Evaluasi

Buatlah tabel di bawah ini pada Ms. Excel, dengan ketentuan:

Ketentuan Pengerjaan:
Buatlah tabel di atas

1)
2)
3)

Carilah rengking dengan menggunakan rumus =rank

Carilah hasil dengan fungsi AND, dengan ketentuan bahwa jika nilai angka
lebih besar dari 75, kemudian statusnya masih single maka hasilnya,
“diterima” jika tidak maka hasilnya “tidak diterima”.

Laporan Hasil Seleksi Penerimaan Pegawai Baru

Tahun 2013-2014

Syarat
No Nama Nilai Status Hasil
Angka
1 | Rani 80 Single
2 | Ahmad Andika 86 Menikah
3 | Riki Darmawan 70 Single
4 | Nurhalimah 74 Menikah
5 | Andi 75 Single
6 | Firdaus 90 Menikah
7 | Siti Aminah 78 Single
8 | Fatimah 65 Menikah
9 | Linda Wati 78 Single
10 | Sugeng Wanto 56 Menikah
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K. Materi Pertemuan Kesebelas (Mengaplikasikan Fungsi

Microsoft Excel.

1. Tujuan Materi Perkuliahan:

Lookup pada Microsoft Excel.

2. Materi Perkuliahan:

Fungsi lookup adalah fungsi untuk mencari data dari suatu tabel, dimana

tabel harus disertakan dalam lembar kerja. Fungsi lookup secara umum dibagi

Mahasiswa mampu mengaplikasikan Fungsi

menjadi dua, yaitu: vlookup dan Hlookup.

Fungsi Lookup di bagi 2

bagian

Vlookup

Hlookup

Gambar 2.48: Pembagian Lookup

a. Vlookup

Vlookup adalah fungsi yang digunakan untuk mencari data dari suatu tabel

secara vertikal.

Format: =viookup (sel yang diuji;tabel data;nomor urut kolom hasil) Atau

=Vlookup(A7,$B$18:$D$20,2)

Contoh:

ELECTRONIC STCRE

<CLE JEHIZ H&3Ea
RIRE  ARANE | IUHIT

-LKILaH
BASAHE

A

HARES

w
1 SVLOOEURISS SER14: 208

o %)

LoAl WEERLAKIE

3

1z

Jeiis sardiz dar hargz unil s oder2an

E

12

meggtakzn tabzl do - fungsi

L u

vkl ] bezaszr<an <ode bara“g

¥oUE LerLdpd L pardd sws

i

fomztya -VLDOEL PRSI 1880520,

THEEL
s0CE JEv %
SARANZ | BARANG

AL

L5

4 =1EN

Tatal h=rza c oo 1 denzon rznghzlikea hz-za u-it
cangz1tetal ~arga

Gambar 2.49: Penggunaan Vlookup

49

Lookup pada



b. Hlookup
Fungsi Hlookup adalah suatu fungsi digunakan untuk mencari data dari suatu
tabel secara horizontal.
Format: = Hlookup (sel yang diuji;tabel data;nomor urut kolom hasil) Atau
=Hlookup (A5,$C15:$E17,2)

F SR TR ETRNF
EZoL JLwF: T B O -14L
FalaMy | Zafesn  HHIT | 36RaNG | HAR e
DAL AL AL Ll LAEA MURLAL
dakd {TH J=nis herarg den nzrge v ad cisi dergea
Jaka Tensguraksr tahel de o furgsi
2 L i1 1} Wl wloc g kerderarker koce Earang
= -F 25008 ] waug Lerdensd padd o=l
- s 2550 n lonealiye z — HLDGRLP|ASSCS 1SS 28172
Tora kargs elear e cagar mcnpal mn Aceps et
eragar refal korps
ThIE-
L ] L]
S LESEH: E] 2 il
IR L i H= [ Sukd
=208 LN T
el R

Gambar 2.50: Penggunaan Hlookup

3. Tugas/ Latihan
Buatlah tabel di bawah ini pada Ms. Excel, dengan ketentuan:

Ketentuan Pengerjaan:
1) Buatlah tabel di atas

2) Isilah tabel di atas dengan ketentuan, jenis barang dan harga unit diisi
dengan menggunakan tabel Referensi dan fungsi Hlookup berdasarkan kode
barang yang terdapat pada soal.

3) Total harga dicari dengan mengkalikan harga unit dengan total harga.

ELECTRONIC STORE

KODE JENIS HARGA JUMLAH TOTAL
BARANG | BARANG (UNIT) BARANG HARGA
1 HP 28,000 25 700,000

3 ? ? 12 ?

3 ? ? 13 ?

2 ? ? 10 ?

1 ? ? 8 2

1 ? ? 20 ?

2 ? ? 10 ?

Tabel Kunci
KODE BARANG 1 2 3
JENIS BARANG HP AC Buku

HARGA (UNIT) 28000 45000 20000
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4.

Evaluasi

Buatlah tabel di bawah ini pada Ms. Excel, dengan ketentuan:

1) Buatlah tabel di atas dengan judul laporan penjualan ticket pesawat terbang
tahun 2015.
2) Untuk mencari tujuan, diperoleh dengan menggunakan fungsi Viookup.
3) Untuk mencari kapasitas, diperoleh dengan menggunakan fungsi IF.
Dengan ketentuan, yaitu:
Jika tujuan Medan maka kapasitasnya 150 orang.
Jika tujuan Rantau Prapat maka kapasitasnya 140 orang.
Jika tujuan Tanjung Balai maka kapasitasnya 120 orang.
4) Untuk mencari sisa tiket, diperoleh dengan cara kapasitas dikurang dengan
jumlah terjual.
5) Untuk mencari harga perunit, diperoleh dengan menggunakan fungsi
Vlookup.
6) Untuk mencari jumlah, diperoleh dengan jumlah terjual dikali harga perunit.
7) Untuk mencari diskon digunakan fungsi IF. Dengan ketentuan yaitu:
Jika hari Sunday maka discountnya 5%.
Jika hari Saturday maka discount 2%.
Dan jika hari lain discounnya 10%.

8) Untuk mencari total penjualan yaitu dengan cara jumlah dikali dengan

discount.
LAPORAN PENJUA_AN TICKET PZEAWAT TERBANG
TAHUN 2015
v WAL HAH KODE  TUL sy | VY] SRR OARSA e | wses g
TERJAL | TISET PEAUNET FalwUs SN
1 14002,2315 Larday IWES TEDEY #50) 12D 30 120003 14430000 205 F20.0I0
? TR IS Vardsy W TAFTHEN 150 1% i TN 15600000 n 1 BRI
b LI 21 Faesder Hit RO | A PRAFA] B 140 i baliid | Y3000 I el LAY B
2 18/0G/2015 Wecesdey WS IDAN 0] 132 o H 120,003 14430000 b1 1,440,000
3 10Md 1015 Trursday IE:) Ta%JURE BALA! 120 1% 1] E5,003 | 10200000 Gl 100 020
5 NS |Fricay NDL  MEDAY 150 13 2| 120003] 1560000 01 1560000
7 25004,2015 Zalaieay T3 TrRNJURE BaLal 0 13 1] £5000 | 10,200.000 J0r 08000
] 12j3/2015 sarday T3 TARIURE BALAI 120 1392 10 £5002| ©350000 J05 167 B0
7 14032015 |Vordar | WP RUNTAL ORAFAT 190 12 20| 65003] 7600000 01 780000
] 15003, 3015 Tiezdey WD TEDE? §500 L1 &0 120003 | 13,300000 0l 1220000
Tabd Kunci
KUDE | L UARN HAKA

NI MFDAN Rp 120,000

RTP RANTAL PRAPAT Rp 65,000

T.B TAMJUMG EALAI Ap 85,0C0
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. Materi Pertemuan Kedua Belas (Mengurutkan Data dan Mengatur Format
Halaman Sebelum Mencetak Dengan Program Ms. Excel)

. Tujuan Materi Perkuliahan: Mahasiswa mahasiswa mampu mengurutkan data
dan mengatur format halaman sebelum mencetak dengan program Ms. Excel.
Materi Perkuliahan:

a. Mengurutkan Data

Pada Microsoft Office Excel di dalamnya terdapat fasilitas untuk

mengurutkan data dengan cepat. Adapun langkah-langkah untuk

mengurutkan data dapat dilakukan dengan cara, diantaranya adalah:

» Blok cell yang akan diurutkan datanya. Misalnya dapat dilihat pada
gambar 2.51 di bawah ini.

NO MNAMA IPK (PREDIKAT
T | Butrisnn A [ hidak Cum 1 aude
2 |Cian 2.5 [Tidak Cum Laude
3 [ Mewri 3.2 |Tidak Cum 1 aude
4 |Har diansah 2.1 | Tidalk Curn Laude
5|Fani 3.7 |Curn Laude
B | Syalrizal 2.9 |Curm _aude
7 |Fatmi JA.8|Cum Laude
# | 1linda 2L Cum L aude

Gambar 2.51: Data yang Diurutkan

» Klik menu Home
» Kemudian pilih Sort & Filter, maka akan muncul kotak dialog seperti
pada gambar 2.52.
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Gambar 2.52:
Kotak Dialog Sort & Filter

Keterangan:
Jika anda memilih Sort Smallest to Largest artinya anda akan mengurutkan
dari angka terkecil keterbesar dan jika memilih Sort Largest to Smallest itu
berarti sebaliknya.

» Setelah di pilih Sort Largest to Smallest, maka akan muncul kotak dialog

Sort Warning. Seperti pada gambar 2.53.

Yot Mdarning ? s

Bpcro s O Excel Tound dzta mekt 1o pcur celadion  hince you haie not
selectec iz cata, Ibwil not De sored,

Whel el yrawan | Lo doT
@ Drpand e se e or;
{3 Corlinuewilie S cun el seleilion

Sorl Cencel

Gambar 2.53: Kotak Dialog Sort Warning

» Pilih Expand the selection
» Kemudian klik Sort, maka akan menampilkan hasil data yang telah

diurutkan berdasarkan yang diinginkan. Hal ini berdasarkan gambar 2.54.

NG NAMA IPK PREDIKAT
1 Autrisng 3.1 Tidak Cum Faude
A Hardianzah 2.1 Tidak Cum Laude
3 Dowi 5.2 Tiduk Curn Laude
2 U 3.5 |jduk Curm Laude
5 Funi 5.4 Cun Loude
H Dinda S i Loude
F Tamml 3.B Cum Laude
E Syatrizal 5.8 Cum laude

Gambar 2.54: Hasil Pengurutan
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b. Mencetak Dokumen
Mencetak dokumen pada Microsoft Office Excel sedikit berbeda dengan
mencetak dokumen di Microsoft Office Word. Perbedaanya, terkadang ketika
mencetak dokumen di Microsoft Excel tidak semua dokumen dapat tercetak secara
utuh. Karena itu, dalam mencetak dokumen di Microsoft Excel perlu pengaturan
agar dokumen yang dicetak akan sempurna. Adapun cara mudah dalam mencetak
dokumen excel agar tercetak keseluruhan bagian adalah:
» Blok bagian cell yang akan dicetak.
» Kemudian klik menu Page Layout.
» Klik Icon Print Area, yang ada pada grup page setup.
» Kemudian pilih, Set Print Area. Maka akan muncul tanda garis putus-putus pada
tabel itu, artinya adalah sebuah batas pada sebuah halaman yang akan dicetak.
» Jika dalam sebuah tabel terdapat garis putus-putus dibagian kolom artinya bagian
tertentu tidak akan tercetak.
» Untuk membuat agar semua bagian tercetak adalah dengan memperkecil Scalenya

pada menu page layout. Kemudian kecilkan Scalenya. Seperti pada gambar 2.55.

| Scales 0%

Gambar 2.55: Memperkecil Scale

» Jika semuanya sudah dapat diatur dengan baik maka cetaklah dokumen dengan
menekan tombol pada keyboard Ctrl+P atau Klik File,
» Pilih Print.

3. Tugas/ Latihan
1) Tuliskan langkah-langkah cara mengurutkan data pada Ms. Excel?
2) Tuliskan perbedaan antara Sort Smallest to Largest dengan Sort Largest to
Smallest?

4. Evaluasi

1) Tuliskan langkah-langkah cara mengurutkan data pada Ms. Excel
menggunakan Sort Smallest to Largest?

2) Tuliskan Langkah-langkah cara mencetak dokumen di Ms. Excel?

3) Tuliskan langkah-langkah cara memperkecil dokumen pada Ms. Excel ketika
di cetak (print)?
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. Materi Pertemuan Kedua Belas (Membuat Media Presentasi dari Microsoft
Power Point).
. Tujuan Materi Perkuliahan: Mahasiswa mampu membuat media presentasi dari

Microsoft power point

. Materi Perkuliahan:

a. Membuka Aplikasi Microsoft PowerPoint 2016
Membuka Microsof Office PowerPoint 2016 terdapat beberapa cara, akan
tetapi pada pembahasan ini akan dibahas mengenai dua cara dalam
membuka aplikasi Microsof Office PowerPoint 2016, di antaranya adalah:

Cara l:

Mendoubel klik icon Microsoft Office Power Point 2016 ; , yang
terdapat pada desktop. Hal ini dapat ditunjukkan pada gambar 3.1 di bawah

ini.

[re

Doulsle Elik Icon

' Sl |l

Gambar 3.1: Icon Power Point 2016.

Caralll:

» Kilik tombol Start E yang ada pada di taskbar .

» Kemudian klik menu All Apps,

» Kemudian cari Microsoft Office PowerPoint 2016.

» Arahkan pointer ke PowerPoint 2016 dan kemudian klik program

aplikasi PowerPoint 2016 tersebut.
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» Setelah di klik program aplikasi Microsoft PowerPoint 2016, maka akan

terbuka program aplikasi Microsoft PowerPoint 2016 tersebut.

a 3

—y———— ——a

fipc=ris

e e e e el SALLLAT ’ '"W'[ WD TYIL
2 L

E m !-‘: W“".Dr'. .-:_j
[t TN S "1’;#

bne e | i

| CRIDEND
- -

—_—

Uy e Pramnlon

Gambar 3.1: Tampilan Awal Microsoft PowerPoint 2016
Keterangan:

1) Kolom search: berfungsi untuk melakukan pencarian template atau
tema dari projek atau dokumen yang ingin anda buat.

2) Open Other Presentations: berfungsi untuk membuka kembali
dokumen atau lembar kerja yang pernah anda buat sebelumnya.

3) Template: Dokumen berisikan berbagai model tampilan yang muncul
pada saat proses pembuatan dokumen lain yang telah disediakan
oleh Microsoft PowerPoint 2016.

» Pada tahap awal dalam memulai pekerjaan dengan menggunakan
aplikasi Microsoft PowerPoint 2016, maka dapat dengan memilih menu
Blank Presentation.

» Setelah melakukan langkah-langkah di atas dalam membuka aplikasi
Microsoft Office PowerPoint 2016, maka akan tampil halaman kerja
Microsoft Office PowerPoint 2016. Gambar 3.4 merupakan tampilan kerja
Microsoft PowerPoint 2016.
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Gambar 3.2: Halaman Kerja Microsoft Office PowerPoint

Keterangan:

1)

2)

3)

4)

5)

6)

Toolbar Quick Access: Secara default berisi tombol Save, Undo, dan
Repeat (Redo). Namun jika ingin menambah dengan mengklik tombol
panah kebawah yang terdapat pada toolbar quick access yang terdapat
diujung kanan.

Menu bar: Merupakan menu-menu yang memiliki fungsi yang berbeda-
beda setiap menunya. Menu bar terdiri dari menu File, Home, Insert,
Design, Transitions, Animations, Slide Show, Review, View dan yang
terakhir adalah Tell me.

Ribbon: Berisi beberapa grup icon dimana setiap icon memiliki fungsinya
masing-masing.

Slide Aktif: Slide yang menunjukkan terdapat aktifitas pembuatan
dokumen presentasion yang sedang dikerjakan.

Halaman Kerja: Untuk memasukan objek seperti teks, gambar video
maupun unsur multimedia lainnya.

View Control: Memiliki bebapa fungsi antara lain dapat menampilkan
dokumen menjadi mode Normal, Page layout dan Page Break Preview.
Kemudian terdapat Kontrol Zoom berfungsi sebagai penentuan ukuran

halaman kerja di layar pada jendela Microsoft PowerPoint 2016.
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b. Memyimpan File Microsoft Office PowerPoint 2016.

> Klik tombol File MM |alu Kik Save As. & = dengan

menekan pada Keyboard tombol Ctrl+S atau juga icon = untuk di toolbar
quick access toolbar.
» Kemudian akan menampilkan kotak dialog Save As, maka akan tampil

pilihan dimana file akan disimpan. Jika ingin menyimpan di komputer
maka Klik This PC = "

Save As seperti pada gambar 3.5 di bawah ini.

. Maka akan muncul kotak dialog

[ e =
-.z'-_, [Lel o e Tt | ] et e B
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Gambar 3.5: Kotak dialog Save As PowerPoint 2016
» Pada kotak dialog tersebut, ketikkan nama file dokumen pada kotak File
name, dan pilih type penyimpanan pada Save as Type.
» Lalu klik Save.

c. Membuka Dokumen Baru
» Klik menu File
» Kemudian klik New atau dengan cara menekan tombol pada keyboard
Ctrl+N.

> Kemudian Pilih Blank Presentation.

d. Membuat Slide Baru

> Klik Menu Home
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» Kemudian klik icon =+

» Atau dengan cara menekan tombol keyboard Ctrl+M.

e. Membuat Slide Interaktif

Design template pada Microsoft Office PowerPoint 2016 sudah tersedia,

namun dapat juga menggunakan templete yang di luar dari yang disediakan

oleh Microsoft Office PowerPoint 2016. Adapun cara membuat desain

template adalah:

» Klik menu Design.

» Kemudian pilih pada grup Themes, salah satu thema yang telah tersedia
pada Microsoft Office PowerPoint 2016. Hal ini seperti pada gambar 3.7

di bawah ini.

- ||--lﬂ‘s%ii Igg.l

il g

M Frer Sonmt Theus

—

Gambar 3.7: Pemilihan Design Template

» Setelah muncul kotak dialog di atas tersebut, maka dapat memilih pada
grup Variants, desain dari template yang dipilih. Ada beberapa contoh

variants, maka pilihah salah satunya. Hal ini dapat di lihat pada gambar

3.8 di bawabh ini.
—. .
| N T

IE‘ Capm ]
D Sfsrs b

-'!-:ll Satkgrour o 5ty 'es ]

Gambar 3.8: Variants Design

» Apabila kurang menyukai warna background theme. Anda dapat
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menggubahnya melalui menu Design dan kemudian pilih tema yang ada
pada grup Variants. Kemudian pilih Background Style. Kemudian akan
muncul berbagai pilihan warna background. Hal ini seperti pada gambar
3.9 di bawabh ini.

%ﬂ Format Ecckground...
Gambar 3.9: Pilihan Warna Pada Background

Atau dapat juga mengubah style background secara manual dengan
cara mengklik Format Background pada kotak dialog Background Style.
Karena pada pilihan tersebut, dapat mengatur style lebih detail sesuai
yang diinginkan. Hal ini sebagaimana gambar 3.10 di bawah ini:

Mormat Bacggroung ™ £

=T

o Seabd Tl

Patticrn il
| Hitle b sgroned grage

ol Ly

Trurmparziow | LT =

| spplyte sl

Gambar 3.10: Kotak Dialog Format Background
» Kemudian klik Apply to All.
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3. Tugas/ Latihan

v’ Latihan 1
Buatlah slide di bawah ini :

Slide |

Slide Il
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v' Latihan 2.
Buatlah slide di bawah ini dengan menambahkan Autoshape

Slide |

A. Akhlak Mahmudah

Perkataan,
Pergaulan.

Kemavan

Kenyaluan

Slide Il

Bohong
Tngkar Janji
Salesi Palsu

Filnah

Cunjing

¥
¢
!
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Evaluasi

Buatlah slide di bawah ini dengan menyisipkan tabel

Slide |

NAMA MALAIKAN DAN TUGASNYA

[ro [vawa — [ruans

1 HH MEIYAR PAIKAN WAHYLI
2 MHEAIL MENURUMENN HUIAN
% | I5HAFH AT MIELTE SAMNGGKAKAL &
1 [ZRAIL MEMCABUT MYAWES
s RIS AH AT MARKNYA| RMAYAL 11ALAR KUITLIE T RIANG 8RAAL YA
DA B
B MAKIR MEMNANYAI MAYAT DALAKM KUBLR TENTANG ARAL YANG
BURUEK
[{ARIE MENUAIR] ANMAL BEBAIKAN
ATID MEMCATAT AMAL KEBURUKAN
2 MNTALIK NIERIAGA 'IMEL NERSKA

| L8 REDWAAR

Slide Il

MEMIAGE FINTU 3YURGA

| |

Perubahan Paradigma Belajar

PINGETAHUAN

Pengetanian dipandang sebagai
sesuamyg sidahiad] yaingzaldi

transfercaridosen ke mehasizwa

BELAJAR

Pengetahuan hasi kensmukei
thenmukan), atayu hasil transfu ras

=8zeorang yang sadzang belzjar

Belzjar adalah menerma
pengetahuanpasiresenti’ )

Belajar adalah mencari dan

MINGATJAR

Menvampalkan pengatahuan

Bzmparizipacsidenganmahasi=wa

' (ceramah/uliah) dalammembenuik pencetanuan
Menialankan sebuah instruksi Menjglankan berbacal sirateai
yang telahdirancang membantu mahasiswa belajar
E IMEMBELAJARKAN)
i ‘_.l
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. Materi Pertemuan Kedua Belas (Mahasiswa Mampu Membuat data base dari
Microsoft Access).
. Tujuan Materi Perkuliahan: Mahasiswa mampu membuat media presentasi dari

Microsoft power point

. Materi Perkuliahan:

a. Membuka Aplikasi Microsoft Office Access 2016
Untuk membuka aplikasi Microsoft Office Access 2016, antara lain dapat
dilakukan sebagai berikut ini:

Cara I:

» Mendoubel klik icon Microsof Office Access 2016 m yang ada pada
desktop.

Cara ll:

» Klik Tombol Start E yang ada pada taskbar.

» Kemudian pilih All Apps

» Kemudian cari Access 2016

» Kemudian arahkan pointer ke Access 2016 dan kemudian klik program
aplikasi Access 2016 tersebut. Hal tersebut dapat dilihat pada gambar
2.1 di bawabh ini.

et wWear s in ares
e

Mizealt Beue

Chouty

Gambar 4.1: Membuka Microsoft Access 2016
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» Setelah di klik program aplikasi Microsoft Office Access 2016, maka akan
menampilkan tampilan awal lembar kerja seperti pada gambar 4.2 di

bawabh ini.

Access o g 2 3 s |
Facen|

P T Dl 1 PRTTTI R,  Bew P L
P A

B

Gambar 4.2 Tampilan Awal Microsoft Access 2016

Keterangan:
1) Kolom search: Berfungsi untuk melakukan pencarian template atau
tema dari projek atau dokumen yang ingin anda buat.
2) Open Other File: Berfungsi untuk membuka kembali dokumen atau
lembar kerja yang pernah anda buat sebelumnya.
3) Template: Merupakan model-model tampilan untuk database yang
telah disediakan oleh Microsoft Access 2016.
Kemudian untuk memulai mengunakan Microsoft Office Access 2016, maka
dapat memilih Blank Desktop Database untuk membuka lembar kerja

tersebut.

b. Membuat Database
Dalam membuat database dengan menggunakan Microsoft Office Access

2016, maka dapat mengikuti langkah-langkah di bawah ini.

» Klik Blank Desktop Database, maka akan muncul kotak dialog. Pada
kotak dialog tersebut, kemudian ganti nama databasenya dengan
meletakan file database pada folder tertentu dengan mengklik icon folder

pada kotak dialog tersebut. Pada contoh di bawah ini merupakan proses
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penyimpanan file pada folder dokumen yang terletak di Local C. Hal
tersebut dapat dilihat pada gambar 4.3 di bawah ini.

Blank desking database

Sheald | ziezke ar Aocess 2opooron Aodess ceskbon catak ooy

,
: Fiim bdart e
DATA PERLLLAL AN
Chlmem' | WARD &M% FLozu ey

L

Gambar 4.3: Proses Pembuatan Database

» Kemudian klik Create. Maka akan muncul lembar kerja dari Microsoft
Access 2016. Lembar kerja tersebut dapat dilihat pada gambar 4.4 di
bawah ini.

(s
N ¥

Gambar 4.4: Halaman Kerja dari Microsoft Access 2016

Keterangan:

1) Toolbar Quick Access: Secara default berisi sejumlah tombol Save,
Undo, dan Repeat (Redo). Namun, jika ingin menambah dengan
mengklik tombol panah ke bawah yang terdapat pada toolbar quick
access yang terdapat diujung kanan.

2) Menu bar: Merupakan menu-menu yang memiliki fungsi yang berbeda-

beda setiap menunya. Menu bar terdiri dari Menu File, Home, Create,
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Eksternal Data, Database Tools, Fields, Table dan yang terakhir adalah
Tell me.

3) Ribbon: Berisi beberapa grup icon dimana setiap icon memiliki
fungsinya masing-masing.

4) Tabel Aktif: tabel yang menunjukkan terdapat aktifitas pembuatan
database pada Microsoft Office Access 2016 yang sedang dikerjakan.

5) Halaman Kerja: Merupakanlembar kerja tempat untuk memasukan

record atau isi dari tabel.

c. Menganti Nama Tabel
Pada Microsoft Office Access tabel yang tersedia namanya dapat diubah
atau diganti sesuai dengan yang diinginkan. Adapun cara mengganti nama
tabel adalah:
» Klik kanan pada tabel.
» Kemudian pilih Design View. Maka akan tampil kotak dialog Save As,

seperti pada gambar 4.5 di bawah ini.

g
-
2 §S
Fan
&
iX:

= HEN] iy b
T_Passa

Gambar 4.5: Proses Merubah Nama Tabel

» Selanjutnya, ganti nama tabel tersebut dengan mengetikkan nama tabel
yang diinginkan.
» Kemudian klik OK.
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d. Mengisi Field Name

Setelah berhasil mengubah nama tabel, maka langkah selanjutnya adalah
mengisi nama field dari tabel yang telah diganti namanya tersebut. Contoh

gambar 4.6. di bawah ini adalah hasil field yang sudah diisi Field Namenya.

ante tanls  FATA_PFMIIALAM = Tist

_reate bxdtemal Lata Uatabase lccls ‘;’ | 2lF me what yol v

D . ;E reprt Fowe . = F L1
- : F—fu 1= = i

5% Deeta Rows

View  Frimany Builder Test Validation = . Froperty Indeces CreateDzta  Rename!
- ke Hules = Modify Lookups Sheet Macros = Lelate Macro
ViEws Toals: 3nowiHide Fleio, Recond & Table Events
| = . : =1 bl Mzhasisaa
All Access Obje... @ « || = m.me
| Fipid Mame nata Tyne
L ol 7
[ & 1D _MAHASISWA Nurmber
Tablcs | -
[ MNAMA MAHASIEWA Lonz Text
I tbi_ Mahasiawe [ lemis KELARAIN short 1axt
! TANGGAL_LAKIR DaleTime
| TEMPAT LAINR Long Text
ALMMAT Long Text

Gambar 4.6: Proses Pengisian Field Name

Adapun cara mengisi Filed Name adalah:
» Klik pada posisi baris field yang diinginkan.
» Kemudian ketikkan nama Field Name. Misalnya, ID_MAHASISWA
» Kemudian tentukan Data Type. Misalnya, Number.

Jenis Data Type

Data type dalam Microsoft Office Access terdiri dari beberapa jenis.

Diantarnya jenis data type tersebut, adalah:

v Short Text: Digunakan untuk menerima input data berupa karakter atau
gabungan antara karakter dan angkaHingga 255 karakter.

v' Long Text: Digunakan untuk menerima input data berupa karakter atau
gabungan antara karakter dan angkaHingga 64.000 karakter.

v' Number: Digunakan untuk menerima input berupa angka sampai 16 byte
besarnya yang biasanya digunakan untuk melakukan perhitungan.

v/ Data/Time: Digunakan untuk menerima input berupa tanggal dan waktu
hingga 8 byte.
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v Memo: Digunakan untuk menerima input berupa teks atau kombinasi teks
dan angka yang panjang atau berjumlah karakter banyak.

v/ Currency: Digunakan untuk menerima input berupa nilai mata uang
hingga 8 byte.

v' Auto Number: Digunakan untuk menerima input data berupa nomor urut
hingga 4 byte.

v Yes/No: digunakan untuk menerima input data yang memerlukan dua
pilihan jawaban. Misalnya kawin/tidak kawin, laki-laki/wanita menampung
data hanya 1 byte.

v' OLE Object: Digunakan untuk menerima input yang berisi objek gambar
dan grafik dan mampu menampung data sampai 2GB.

v Hyperlink: Digunakan untuk menerima input yang berisi alamat hyperlink
atau URL Dan dapat memuat hingga 2048 karakter.

v' Attechment: Digunakan untuk menginput data berupa objek gambar atau
dokumen tipe data ini menampung sampai 2GB besarnya.

v Calculated: Diciptakan untuk meminimalkan kesalahan perhitungan
selama proses perhitungan.

v' Lookup Wizard: Merupakan tipe data yang dapat menggabungkan

beberapa tabel untuk menampilkan data.

. Menghapus Field Name

File Name yang yang telah dibuat dapat diedit maupun diharus. Adapun

langkah-langkah menghapus field, yaitu:

» Blok field yang akan dihapus yaitu dengan cara mengarahkan pointer
mouse didepan field yang akan dihapus. Pastikan bentuk mouse pointer
berubah menjadi tanda - . Kemudian klik tombol mouse.

» Kemudian, tekan tombol Delete pada keyboard atau klik Delete tool pada

toolbar Record. Hal ini sebagaimana gambar 4.7 di bawah ini.
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Gambar 4.7: Proses Menghapus File Name

f. Mengisi Record Pada Tabel

Setelah membuat nama field, maka langkah selanjutnya dapat mengisi
record sebagai isian dari tabel Mahasiswa. Isikan record seperti gambar 4.8

di bawabh ini.
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Gambar 4.8:

g. Menyinpan File Database
Menyimpan File Database Baru.
» Klik menu File
» Pilih Save AS

Proses Mengisi Record

» Kemudian pilih File Typenya dengan, Save Database As.

» Kemudian klik Save AS. Hal ini seperti gambar 4.9 di bawah ini.
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Gambar 4.9: Proses Penyimpanan File Database

> Setelah di klik Save AS, maka akan keluar kotak dialog yang
memerintahkan untuk memilih lokasi atau directori penyimpanan file

database. Seperti pada gambar 4.10 di bawah ini.
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Gambar 4.10: Memilih Directori Penyimpan File Database

» Kemudian tentukan File namenya. Misalnya. Data Penjualan 1, dan
tentukan juga Save as typenya. Mislanya, Microsoft Access Database.

» Kemudian klik Save.

Cara Menyimpan Dokumen Yang Sudah Pernah Disimpan

Sebelumnya.

Cara ini pada umumnya digunakan ketika sudah pernah menyimpan file

tersebut dan kemudian melakukan sebuah perubahan atau Editing.
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Adapun cara melakukan penyimpana dokumen yang sudah pernah
disimpan sebelumnya adalah:

» Klik menu File

» Kemudian klik Save atau dengan cara tekan tombol keyboard Ctrl+S

secara bersamaan.
h. Membuat Tabel Baru

Dalam satu database dapat dibuat beberapa tabel, maka adapun cara

membuat tabel baru, setelah pembuatan tabel yang sebelumnya adalah:

> Pilih menu Create.

=

» Kemudian pilih icon tabel . , pada grup tables.

» Kemudian ubah nama tabel tersebut dengan cara klik kanan pada tabel
baru, kemudian pilih Design View. Maka akan muncul kotak dialog Save
As, setelah itu ganti nama tabel tersebut dengan nama tabel yang
diinginkan. Kemudian klik OK.

» Setelah tabel terbuat diubah nama tabelnya, maka isikan field namenya
dan juga data typenya sama seperti pembuatan diawal.

» Kemudian isilah record pada tabel tersebut.

i. Membuat Relasi Antar Tabel

Relasi tabel dapat juga disebut hubungan antartabel. Pada umumnya relasi

tabel dilakukan pada tabel yang masih berada dalam satu database. Relasi

tabel memiliki fungsi bila pada tabel yang direlasikan terdapat satu field yang

sama dan field tersebut akan dijadikan sebagai Primary Key. Contoh:

terdapat dua buah tabel yang akan dibuat relasi tabel, yaitu “Tabel

Mahasiswa” dengan “Tabel Mata Kuliah”.

» Pastikan terdapat field yang sama pada kedua tabel (tabel mahasiswa
dan tabel matakuliah) yaitu, ID_MAHASISWA.

» Klik Database Tools.

» Kemudian, Klik icon Relationship yang terdapat pada grup Relationship.
Maka akan muncul tabel yang ada pada database, seperti pada gambar
4.10 di bawah ini.
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Gambar 4.11: Tabel Relationship

» Untuk membuat relasi antar tabel dapat mengklik tombol Edit
Relationship yang ada pada menu design pada grup Tools. Kemudian

akan muncul kotak dialog seperti pada gambar 4.12 dibawabh ini.
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Gambar 4.12: Edit Relationships
» Kemudian klik tombol Create New. Kemudian akan muncul sebuah

Kotak dialog dan isikan seperti gambar 4.13 di bawabh ini.
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Gambar 4.13: Pemilihan Primary Key Untuk Kedua Tabel
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> Kemudian klik OK.

» Kemudian klik tombol Create. Maka hasilnya akan ditampilkan seperti

pada gambar 4.14 di bawah ini.
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Gambar 4.14: Hasil Pembuatan Relasi Antar Tabel

Mengelola Database Mengunakan Query

Query adalah sebuah cara untuk menambah, menghapus, merubah, dan
menampilkan isi data dari tabel-tabel yang ada pada sebuah database.
Bukan hanya itu dengan Query juga dapat menghapus dan menambah tabel
kemudian juga dapat menambah dan menghapus sebuah database, itu
semua dilakukan dengan cara memasukkan kode atau syntaks tertentu.
Pada pengunaannya query hampir sama dengan filter yang mampu
mengambil suatu nilai tertentu. Adapun cara mengunakan Query antara lain
adalah:

» Pastikan memiliki satu tabel atau lebih yang sudah dibuat sebelumnya.

> Klik menu Create
K]

Suery
» Kemudian klik icon Query Design E=isn, pada grup Queries.

» Kemudian akan muncul kotak dialog Show Table. Seperti gambar 4.15

di bawabh ini.
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Gambar 4.15: Pemilihan Tabel Untuk Query
» Pilinlah salah satu tabel atau beberapa tabel yang akan dijadikan query,
dengan menekan tombol Add. Kemudian klik Close. Maka akan

ditampilkan tabel seperti gambar 4.16.

LB

Gambar 4.16: Tampilan Tabel Yang Sudah Dipilih

» Ketika tampil satu tabel yang dipilih tadi. Pada menu Design klik icon
=

View | & dan pilih SQL View

» Kemudian akan muncul sebuah kotak Query di mana akan dapat

Sqi_ SO Wairw

memasukkan kode query pada kotak tersebut. Hal ini dapat dilihat pada

gambar 4.17 di bawah ini.
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Gambar 4.17: Kotak Query

k. Membuat Form Aplikasi.

Pada Microsoft Access disediakan sebuah fasilitas Form yang berfungsi
untuk membuat sebuah aplikasi sederhana pada Microsoft Access yang
dapat didesain sendiri tampilannya. Sebelum membuat Form anda harus
memiliki sebuah database yang nantinya akan dilakukan sebuah operasi
pada database tersebut. Pada tahap kali ini maka sebaiknya untuk membuat
Form mengunakan database yang sudah dibuat sebelumnya dan
mengunakan tabel Mahasiswa. Adapun tata cara pembuatan form dapat

dilakukan dengan cara berikut ini.

» Clik Menu Create

> Kemudian pilih Form Wizard taFemWisard o242 grup menu Form.
» Maka akan muncul kotak dialog Simple Query Wizard. Arahkan semua
field kesebelah kanan dengan mengklik tombol ">>" kemudian klik Next.

Hal ini dapat dilihat pada contoh gambar 4.29 di bawah ini.
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Gambar 4.29: Kotak Dialog Simple Query Wizard

» Pada kotak dialog Form Wizard, maka Pilih Columnar dan kemudian klik
Next. Hal ini dapat dilihat pada gambar 4.30 di bawah ini.
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Gambar 4.30: Kotak Dialog Proses Pemilihan Style Form Wizard

» Pada kotak dialog Form Wizard, yang terdapat pada What title do you Want for

your form?, maka ubah Judul Form yang tadinya “tbl_Mahasiswa” menjadi
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“Form Aplikasi” dan klik Finish. Hal ini sebagaimana pada gambar 4.31 di
bawah ini.
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Gambar 4.31: Kotak Dialog Pembuatan Form Wizard

» Setelah di klik finish, maka pembuatan form telah selesai dan akan

menampilkan sebuah form yang berisi data pada record pertama. Hal ini
dapat dilihat pada gambar 4.32 di bawah ini.
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Gambar 4.32: Halaman Form Aplikasi

» Untuk mendesain tampilan form dan menambahkan beberapa tombol
proses seperti save, add dan lain sebagainya. Langkah awalnya adalah
dengan klik menu Home, Kemudian pilih icon View selanjutnya pilih

layout View. Hal ini seperti pada gambar 4.33 di bawah ini.
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Gambar 4.1: Layout View

Pada menu Design, maka dapat memilih beberapa Controls yang
mendukung dari form yang dibuat saat ini. Pada tahap kali ini penulis

hanya mengambil Button untuk melakukan Save dan Edit. Hal ini seperti
gambar 4.45 di bawah ini.
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Gambar 4.45: Tools Pada Form
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Klik Controls Button kemudian drag kebagian bawah form kemudian klik
dimana akan meletakkan button tersebut. Akan muncul sebuah kotak
dialog Commad Button Wizard, Pilih Record Operations dan actionsnya

Pilih Save Record, Dan Klik Next. Hal ini dapat dilihat pada gambar 4.46
di bawah ini.
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Gambar 4.46: Tampilan Commad Button Wizard

» Selautnya adalah proses pembuatan nama button. Ubah nama button

menjadi “Save”. Seperti gambar 4.47 di bawabh ini.
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Gambar 4.47: Pembuatan Nama Button

» Kemudian klik Finish. Selanjutnya Drag Button dan tempatkan button

paling bawah, seperti pada gambar 4.48 di bawah ini.
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Gambar 4.48: Hasil Pembuatan Button Save

» Untuk menguji apakah button “Save” yang dibuat sebelumnya sudah bekerja
atau tidak dapat melakukan dengan cara klik icon View pada menu Home.
Pilih Form View. Selanjutnya merubah nama dari Aldian menjadi Alvian.

Kemudian klik pada button Save. Hal ini dapat dilihat pada gambar 4.49.
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Gambar 4.49: Pengujian Button Save

» Setelah mengklik Tombol Save. Lihat tabel mahasiswa sudah berubah nama

Aldian Menjadi Alvian. Itu artinya bahwa Button Save yang dibuat sebelumnya

sudah berhasil. Hal ini dapat dilihat pada gambar 4.50 di bawah ini.
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Gambar 4.50: Hasil Pengujian Button Save

» Setelah pembuatan tombol “Save” berhasil maka buatlah tombol “Delete”. Perbedaan
dari pembuatan tombol Delete dan tombol Save adalah hanya pada proses Commad
button Wizard. Untuk tombol delete dapat memilih Action Delete Record seperti

contoh pada gambar 4.51 di bawah ini.
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Gambar 4.51: Pembuatan Tombol Delete

» Kemudian pilih Delete Record, dan klik tombol Finish. Selanjutnya Drag Button

dan tempatkan button paling bawah, seperti pada gambar 4.52 di bawah ini.
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Gambar 4.52: Hasil Pembuatan Tombol Delete

I. Membuat dan Mengatur Report
Membuat Report
Report memiliki fungsi untuk menampilkan informasi data menggunakan
format laporan. Adapun cara membuat report adalah:
» Klik menu Create.
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» Kemudian pilih Report . Maka secara automatis akan tampil

bentuk report, seperti pada gambar di bawah ini.
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Gambar 4.53: Data Report

Mengatur Format Report

Mengubah Judul Report

Adapun langkah-langkah megubah judul Report, adalah:

» Mengklik judul report.

» Kemudian ubah judul report sesuai dengan yang diinginkan.

» Kemudian Enter.

Mengubah Posisi Kertas

Adapun langkah-langkah megubah posisi kertas dari portrait menjadi
landscape, adalah:

» Klik menu Page Setup

» Pilih Portrait untuk merubah ke bentuk vertical atau pilih Landscape

untuk merubah ke bentuk horizontal. Hal ini seperti pada gambar
4.54 di bawah ini.
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Gambar 4.54:2 Merubah Posisi Kertas Pada Report
Mengatur Lebar Kolom
Adapun langkah-langkah untuk mengatur lebar kolom report, adalah:
» Aktifkan salah satu kolom report terlebih dahulu.
» Kemudian, arahkan mouse pada salah satu sisi kotak tanda aktif.
» Kemudian, untuk mengatur lebar kolom yang diinginkan lakukan

dengan drag. Hal ini dapat dilihat pada tabel 4.55 di bawabh ini.
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Gambar 4.55: Hasil Pengaturan Lebar Kolom

Menampilkan dan Mencetak Report

Menampilkan Report (Print Preview)

Adapun langkah-langkah untuk menampilkan report, adalah
» Klik menu Design.

» Kemudian, klik View pada grup views.

» Kemudian klik Print Preview. Maka akan tampil gambar 4.56 di

bawabh ini.
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Gambar 4.36: Print Preview
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Menceteak Report

» Setelah melakukan print preview, klik tombol Print yang terletak
disudut kiri bagian atas.

» Kemudian akan tampil kotak dialog Print, kemudian atur bagian yang

ingin diprint pada report. Proses pengeprintan report tersebut dapat

dilihat pada gambar 4.57 di bawah ini.
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Gambar 4.57: Mencetak Report

3. Tugas/ Latihan

Buatlah tabd kedua dengan namafile: DATAKARY AWAN, dengan struktur sebagai berikut:

File Name Data Type Fidld Size
NIK Short Text
Nama_Karyawan Long Text
Jabatan Short Text
Gaji Number

Kemudian masukkan data seperti di bawah ini:

NIK Nama_Karyawan Jabatan Gaji
D001 Dani Irawan Dosen Tetap 2000000
D002 Rudi Ismanto Dosen Tidak Tetap 1500000
D003 Dinalriani Dosen Tetap 2500000
D004 Dini Aprilia Dosen Tidak Tetap 1500000
D005 AnggaArifin Dosen Tetap 2500000
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4. Evaluasi
Buat sebuah database yang bernama DATA_SEKOLAH. Dengan ketentuan:
1) Buat 3 Tabel yang pertama TABEL _GURU, TABEL _MATAPELAJARAN,

TABEL_SISWA.
TabelGuru
T TaEeL_cunu 4 EF TABEL_MATATELAJARaN | B3 TAEEL_SISW
Flelo Mame Diata Type
¥ w_=uRu Mumbar
|10 MATAFELAJARAM Mumbor
| MAMA_GLRU Long Text
TANZGAL LAHIR Date/Tirme
-_F".1P'.E|.T_I..|'-".HIR Foyag Texld
| ALAMAT Long Text
| MO HAMUMHOMNE Short ext
GAl Humbor
JENIS KCLAMINM Short Text

Tabel Matapelajaran

= Iabe:_Matzi'eyaran b,

Figld Mame Cra L Type
i |10 W ataPelajaran Mumber
|Mams hataPelajaran Short T2t
dzowal Mengajar thort et
Tabel siswa
i: ~apCL_cURU | B TACCL MATAFCLAIARAN | 15 TADLL_ SIS
i 111 Mame liata IypF
RS N LA YN MNumoer
I Mo SPLLs A AN Mumoer
FLRIA 550 Loing lext
TAMZGAL LAHIR Dzte/Time
[ TEM PAT_LAHIR Short Test
| ALAMAT Lowip Texl
JENI_KELMMWIM St Teal

2) Buat relasi antar ketiga tabelnya seperti pada gambar berikut ini.
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REISELON & T
| B2 TaEEL SURL (= TABEL MATAPELA-ATAN P TAEE. 315%A 1 =8 Relationships ®
| |
TARFI_GLIRLI TARFI _MATARF ALAR _ TARFI_Sl5wa
¥ Gl - % M MATAPT|ALARAN —\_ T In_saa |=
|2_MATAPZLAIARS WARA_METATELA AT, ID_MATAFELAJARA
PIRRSA LU IALVSAL ST=M_ AL MHAKIE HI078
TAKNGGSL_LAHIR TAHZGAL CAHIR
TERSP&T_L&HIR TEMPAT__2HIR
Al AMAT - Al AR AT 5

3) Dari tabel tersebut buatlah query, form, dan report
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